
  

What is VR CNC Milling? 

VR CNC Milling is a Windows based software package allowing full editing and control of CNC 
files, either offline (away from the CNC machine) or online (controlling the operation of a CNC 
machine). 
 
Information is accessed and displayed using an interface similar to other popular software 
applications. The familiar dropdown menus, toolbars and software display windows can be 
configured to suit the level and requirements of each user. Since the software supports full offline 
facilities, it allows many tasks such as setting tool offsets, to be carried out away from the CNC 
machine itself. Options such as these allow groups of students to work simultaneously whilst helping 
to free valuable CNC machine resources. The same interface is used online, allowing students to 
produce their designs without having to learn any new CNC machine control software. 
 

 

Features available in the VR CNC Milling software package include: 
 
Full CNC file editing. 
 
2 Dimensional graphical simulation of CNC files. 
 
3 Dimensional graphical simulation of CNC files. 
 
Comprehensive Tooling features. 
 
Full offline control of a CNC machine using Virtual Reality.
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Full online control of a CNC machine. 
 
Context sensitive online help, including help with G and M code Programming and CNC file 
structure. 
 
 

  

Overview - Screen Layout 

The screen is divided into menus, buttons and windows. Most functions can be selected by choosing 
to either single click on a button located in a toolbar or by selecting from pull down menus. 

How do I use buttons? 

Only a SINGLE CLICK is required when using buttons. For example, to run a 2D - 3D Simulation : 

1. Single click the button.  

2. The button changes and a the 2D - 3D Simulation window appears.  

3. Single click the button again and the window is removed from the screen.  

How do I use the pull down menus? 

The list of pull down menus will change as different windows become active. For example, the 
"Simulation" pull down menu appears, only when the simulation window is active. To activate the 
window, click on the title bar at the top to select it as shown in red below.
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Tool bars 

A toolbar is a group of buttons. 

The diagram below shows how all the different elements of the software work together, from CNC 
file source through to a software or hardware output.
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What's new in version 5? 

Virtual Reality 

 New graphics engine. 
 More detailed models of CNC machines. 
 Actual cutting of the virtual material in jog mode and program cycle. 
 Collision detection, objects change colour when cutter comes into contact with billet etc.. 
 Base / Work holding / clamps shown on the VR machine table (E.g. MDF base, Datum plates).
 Auto Datum facility, program will run without having to set the VR offsets (can be switched 

off). 
 Extra sound effects added. 
 Animated swarf whilst cutting. 
 Ability to create and save custom camera positions in the virtual world. 

Simulation 

 The separate 2D and 3D simulation windows have been replaced as one window. The view 
can be switched between 2D and 3D within the window. 

 Pre-set Datum positions (automatically uses the datum from any one of 10 pre-sets). 
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 Slab Mills and Engraving cutters can now be simulated.

2D View 

 The 2D view can now also display a section view. The position of which can be changed 
allowing cutaway sections to be shown at any point in both the X and Y directions. 

 The depth of cut at the cursor position can be analysed. 
 Zoom to an area and Panning controls added. 

 
3D View 

 Animated swarf whilst cutting. 
 Sound (of machine motors and material cutting). 
 On screen Feed and Speed override dials. 
 'Highlight in Simulation' feature now added to the 3D view.(The toolpaths and G-codes are 

linked,  
 associated elements of the toolpath are highlighted as its related G-code is selected in the 

editor). 
 Ability to change the light source and shadow effects of the displayed part. 

 
Program Pre-scan - as soon as a CNC program is loaded into the editor it... 

 Checks the syntax (program structure and invalid characters). 
 Checks for invalid codes (G code errors). 

 
Program Information window 

 Displays the CNC program as a tool path (Quick preview). 
 Visualises the program in relation to the CNC machine's working area and datum position. 
 Reports errors in the 'Show Warnings' button - useful in solving offsets problems. 

 
Tool and Offset Editor 

 The Offsets, Tooling and Tool library windows have all been combined in to one. 
 The X,Y and Z offsets can all be set by a single button. 
 Multiple copies of the same tool are now allowed. 
 Face Mill and Engraving cutters now supported as a tool type. 

 
Graphical Information 

 Graphical Information window displays information about your graphics settings, useful in 
solving problems with graphics cards / drivers. 
 

Configure Utilities 

 Search button - The software performs a search on the computer for related CAD/CAM 
software and creates a link button. 

 

Page 5 of 16

15/12/2010



  

Recommended Computer Specification 

 

System Requirements 

 IBM or 100% Compatible PC  
 3 1/2 Inch Floppy Drive (for registration disk)  
 Pentium III 500Mhz  
 128Mb RAM  
 Microsoft Windows 98 and above  
 CD-ROM Drive  
 50Mb free Hard Disc space  
 Open GL 3D Accelerator Graphics Card with 32Mb VRAM supporting 1024x768 resolution 

Single Users : 
'Single User' version requires 1 x free parallel port (for security dongle) 
 
For Machine Interface : 
RS232 machine interface requires 1 x free serial port 
USB (optional) machine interface requires 1 x free USB port plus Windows XP/NT/2000 operating 
system 

 

  

   

Registration 

The Registration Details window is used to both view and edit your current registration settings. 

Click on the tabs at the top of the window to access each section : 

General 

Displays the details of the establishment the software is currently registered to. 
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Products 

Displays a list of Denford products currently registered. 

'VR MILLING 5' is the name for this product and Therefore must appear in the list. 
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Product : Displays the name of the currently selected product from the list.

Product ID : The ID number contains information about the product. 

Licences : The number of licences (users) registered for this product. 

Status : Displays 'Registered' when valid. 

Registered Date : 

Modules 

 

Each product can be broken down into one or more modules. 

A module is a particular feature of the software. For example, the Virtual Reality Simulation is a 
module called 'SimVR Output'. Therefore, that module must appear in the list for that feature to be 
available. 

The modules available to the product (selected from the drop down menu) are displayed in the list.  

Product : Displays the name of the currently selected module from the list. 

Product ID : The ID number contains information about the product name and the module. 

Status : Displays 'Registered' when valid. 

Registered Date : 
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Location 

 

The information containing details of which products and modules can run on this computer. These 
can be located in any one of the following places : 

1. File - a local file (usually the hard disc).  
2. Registry - the registry of your operating system.  
3. Security Key - stored in the flash memory of a 'dongle' connected to your parallel port.  
4. Remote - located on another computer on the network.  

Upgrade 
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Upgrading (adding a product or module) will overwrite your current registration key information, 
Therefore it is advisable to make a backup of your existing settings. To do this specify a filename 

(.tff) and click the button. The button is available, as you may be asked to 

email your current setting to Denford support staff. 

To import a new security key :- 

1. Click the [browse] button.  
2. Locate your new registration key file (this will have a .tff file extension).  

3. Click the button  

Check your new registration setting by clicking on the [Products] and [Modules] tabs. 

 

 Technical Support  
 Denford Contact Details  
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Conventions used in this Helpfile 

Mouse Usage 

When asked to click on a menu tile or object, click the LEFT mouse button ONCE. When asked to 
right click on a menu tile or object, click the RIGHT mouse button ONCE. When asked to double 
click on an object, click the LEFT mouse button TWICE. 

"Quotation Marks" 

Quotation marks are used to specify any software menu, title and window selections, e.g. click the 
"File" menu would mean click the left mouse button once, when the cursor is positioned over the 
File menu label. 
 
When a sequence of menu commands are requested, the menu and option names are separated by a 
vertical line, for example - Click "File | Open" would mean open the File menu, then click on the 
Open option. 

 
Bold Text 

Bold Text is used to show any characters, or text, that must be entered, e.g. type file1 would mean 
type the word file1 into the appropriate text entry box. 

 
[Square Brackets] 

Square brackets are used to show any on-screen software button selections, e.g. Click the [OK] 
button would mean click the left button of the mouse once, when the cursor is directly pointing over 
the button labelled OK. 

 
[Bold Square Brackets] 

Bold square brackets containing text show individual keys to press on your qwerty keyboard, e.g. 
press [Enter] would mean press the Enter key. 
 
If a number of keys must be pressed in sequence they are shown with plus signs outside any square 
brackets, e.g. press [Alt] + [Enter] would mean press the Alt key first followed by the Enter key 
second. 
 
If a number of keys must be pressed simultaneously they are shown with plus signs inside any square 
brackets, e.g. press [Alt + Enter] would mean press both the Alt key and Enter key together, at the 
same time. 

 
Screenshots 

Please note that any screenshots are used for explanation purposes only. 
 
Any numbers, wording, window or button positions may be different for the configuration of the VR 
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CNC Milling software you are using. 

 
Language 

Please note that this helpfile is written in European English. 

 
Updates 

We take great pride in the accuracy of information given in this helpfile, but due to nature of 
software developments, be aware that software specifications and features of this product can change 
without notice. No liability can be accepted by Denford Limited for loss, damage or injury caused by 
any errors in, or omissions from, the information supplied in this helpfile. 
 
 

  

4th Axis (option) 

 

To reconfigure the software when the 4th axis option is fitted to your CNC machine you need to 
check the following settings :- 

1. From the pull down menu select the "Setup | Select Machine Parameters" option and enter the 
password (the default password is denny).  

2. Click the 'Machine Capability' from the list.  
3. Type a '1' in the box next to 'IV axis – A,B,C (1,2 or 3)' to activate the 4th axis option as 

highlighted in red below.  
4. Click the [Close] button to exit.  
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The Control Panel will now show the 4th Axis display as highlighted in red below. 
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Control Keys 

The 4th axis can be rotated by using the [.] and [/] keys on the QWERTY keyboard when in jog 
mode. Note: The keys shown above are defined as the default keys when the software is first 
installed. However, it is possible to re-define these keys using the axis key definition table. 

To set the datum (reset the angle to zero) click the  button. 

 

  

Upgrading your NextStep (NS) machine 

To get the best performance out of your existing machine, you need to upgrade some software which 
lives inside your machine. Doing this will give greater speed and smoothness when machining. 
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Be warned, however, that this operation is not fool-proof and could leave your machine "dead" 
until a Denford engineer can fix or replace your NextStep card. Only carry out this procedure 
if you feel technically competent and can afford to be without the machine for a number of 
days. 
There is also a risk of electrical shock carrying out this procedure. 

Step 1: Confirm that you have the correct type of card inside your machine - it should look 
something like this: 

 

If you do not have a green 7-segment display, then you will need to purchase a NextStep upgrade 
card from Denfords before continuing. 

Step 2: Confirm that your PC and machine connections are working OK. To do this, run VR Milling 
and connect to the machine - if you have problems connecting to the machine, then you will not be 
able to upgrade the card either. 

Step 3: Insert your original VR Milling installation CD - select "Install Easy Machine Upgrader" 
from the autorunning menu. 

Step 4: Once this software has installed, run it and click "Check my machine" - the software will 
now tell you whether or not your machine needs upgrading, and will give you the option to do so (if 
required). 
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Step 5: If the software does start to update the machine, please be patient and wait for firmware 
downloading to commence. It is essential that you power-cycle the machine when the updating 
process has completed. 
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Getting Started - Quick Tour 

This Quick Tour is designed as an easy step by step guide to get you connected to your CNC 
machine and to run a CNC program. 

The CNC program could be one you have produced from an external CAD/CAM program, written 
yourself by typing it into the editor or one of the supplied example files. 

Note : The CNC program used in the screens shots is the 'Teddy' program which is one of the 
example files supplied. To run this on a machine we recommend a piece of foam material 100mm 
x100mm x 40mm (4" x 4" x 1.5") and a 6mm (1/4") ball nose cutter. 

In this tour you will : 

1. Connect the computer to a CNC machine   

2. Home the machine   

3. Configure the tools   

4. Use the 'Jog' mode to move each axis of the machine   

5. Jog the cutter to the workpiece datum and set the tool offsets   

6. Load a CNC program into the editor   

7. Validate the program/offsets with 'Program Information'   

8. Run the program on the machine   

9. Disconnect the computer from the CNC machine and exit the software   

 

  

Getting Started - Quick Tour 

Load a CNC Program 

The machine is now configured to run a CNC program. 

To load a CNC program into the editor :
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1. Select "File | Open..." from the pull down menu. 
2. Navigate through the folders to find your file with a .fnc file extension.   
3. Click on the file to select it and then click the Open button to load.  

 

 Program Pre-Scan  

 

  

Getting Started - Quick Tour 

Program Information 

It is advisable that you run a "Program Information" check before running the program on the 
machine as this will : 

 Scan through your CNC program checking for errors.  
 Check the offsets you are using are valid for the working envelope of the machine.  
 Display a graphical image of your program on screen. 

To use the Program Information window. 

1. Click the  button located in the options toolbar as shown below.  

  

2. Check that you don't have any errors appear similar to one below. 
To find out how to resolve error messages click here
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3. Click the button to remove the Program Information window.  

 

 Program Information window  
 Error messages  
 Machine working envelope  
 Running a 2D/3D simulation  

 

  

Getting Started - Quick Tour 

Configuring The Tools 

Configuring the tools ensures the correct tool is used during the simulation. If this is not important 
for you at this stage you can by-pass this section and go to the next page. 

To configure the tools use the "Tool and Offsets Editor" window, the button for this is usually found 
at the bottom of the screen as shown below. 
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To configure tool 1 as a ¼" Ball Nose cutter :  

1. Click the  button.  

2. Left click on the [Tooling Data] tab.  
3. Right click on the "Description" for tool No. 1.  
4. Select "Insert Library Tool" from the pop up menu.  
5. Select the 1-Ball Nose ¼" tool from the tool library selection and click [OK].  

6. Click the  button again to remove the window.  

Alternatively, you can copy and paste to select your tool from the library.  

 

 Tool and Offsets Editor  

 

  

Getting Started - Quick Tour 

Connecting to the machine 

Your computer needs to be connected to the CNC machine via the cable provided. The diagram 
below shows the connection via the RS232 cable. 

Note: If your machine has a USB option, you can connect the USB cable between any USB port on 
your computer to the USB port on the CNC machine.
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It is important that you check that the software is configured for the correct model of CNC machine. 

The current configuration is displayed at the top left of the screen. 

 

This name should be the exact model of your machine. If they do not match then you may find that 
you can connect to the machine but certain functions may not operate correctly, or you may not be 
able to connect at all. To find out which model you have, refer to the plate located on the side or 
back of your machine cabinet. 

To reconfigure the machine name ... 

1. Select 'Setup | Select Machine...' from the pull down menu.  
2. Select the appropriate machine from the list and click the [OK] button.  

Page 5 of 12

15/12/2010



To connect to the CNC machine attached to the computer .... 

1. Ensure the cable is fitted securely between the computer and the CNC machine.  
2. Switch on the CNC machine.  
3. Power up the computer and start the VR CNC Milling software.  

4. Single click the [Machine] button  and wait a few seconds for the software to 'find' 

the machine.   

 

 Troubleshooting connecting to a machine  
 Software Configuration Settings  
 Computer specification  

 

  

Getting Started - Quick Tour 

Homing the machine 

When a real computer successfully connects to the CNC machine, the "Control Panel" window will 
be displayed with only the "Home" tab active, as shown below. 

 

You will need to"Home" the CNC machine each time:
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 It has just been switched on.  
 You are reconnecting the computer to the machine.  

In most cases you can home all three axes at the same time by pressing the XYZ button.  

 

After pressing the button the border on each of the X,Y and Z buttons should go from red to green. 

Note: If you are unable to make all of the buttons turn green, there could be a problem with your 
CNC machine. 

 

 Troubleshooting homing the machine  
 CNC  Theory - Homing the machine  

 

  

Getting Started - Quick Tour 

JOG Mode 

Click the [Jog] tab on the control panel to enter jog mode.  
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Use the cursor keys on the QWERTY keyboard to move each axis around. 

Note: The jog keys will only work when the control panel is active which is indicated by a green 
light as shown below. If it is not active, click anywhere on the control panel window to activate it 
again. 

 

The jog speed can be increased/decreased with the jog dial. 

 

 Jog Controls  

X Axis : [Left] and [Right] cursor keys

Y Axis : [Up] and [Down] cursor keys

Z Axis : [Page Up] and [Page Down] keys
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 Setting the units of measure  

 

  

Getting Started - Quick Tour 

Set the offsets 

The next procedure is to "teach" the machine: 

 Where the workpiece is positioned on the table (setting the X,Y offsets)  
 The point where the tool tip touches the top of the workpiece (setting the Z offset) 

To do this, use the jog keys to move the cutter to the workpiece datum, in most cases this will be at 
the front left hand corner of the part as shown below. 
 

 

Jog the axes so the cutter is at a position approximately 1.5mm (1/16th inch) above the workpiece 
datum as shown. 
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Click the jog step/continuous button to change to step mode. 

 

Jog the cutter down and touch on the surface of the workpiece. 

 

Now you are ready to set the XYZ offsets: 

1. Click the  button to open the Tool and Offsets Editor window.   

2. Click on the [Work Offsets] tab if it is not already selected.  

3. Click the  button to store the XYZ tool position into the offsets table.  

4. Click the  button again to remove the window.  
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 Jog Controls  
 What are Offsets?  

 

  

Getting Started - Quick Tour 

Run the Program on the Machine 

For best results, follow these steps when running a program on your CNC machine :  

Note : Remember to close the guard on your machine. 

1. Select the "File | Source | file" option to remove the editor from the screen.  

2. Click the [Auto] tab to enter auto mode. 
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3. Click the [Turbo] button to enter turbo mode - essential for 3D programs.  

4. Press the [Rewind]  button to make sure the program starts at the beginning.  

5. Press the [Start] button.  - follow the onscreen prompts where necessary.  

 

 Auto Mode  
 Turbo mode  

 

  

Getting Started - Quick Tour 

Disconnect and Exit 

Please follow these steps before exiting the software :  

1. Click the [Jog] tab to exit auto mode.   

2. Click the [Real Machine]  button to disconnect from the CNC machine.  

3. Select "File | Exit" from the pull down menu.  

Thank you for using the Denford QuickTour. 

End. 
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Fast Editor 

 

The Fast Editor is a cut down version of the previous full editor (still available from the File menu). 
It has been introduced to speed up the running and simulating of large CNC files. 
It has a fixed number of lines shown (configurable per machine in the parameters). Any of the visible lines 
can be edited/altered. 

Buttons: 
 

Press this button to go into item help mode. Then click on the G-Code you want more help about. 

Press this button to open general help.  

 Press this button to 'freeze' the editor to speed up a program. In other words, the editor is not 
updated so that all available processing power is used to machine or simulate the program. (Use this in 
conjunction with turbo modes to improve the performance the software). 

Key commands: 

INSERT : will insert a line at the current highlighted line 
SHIFT+DELETE : will delete the whole of the current line 
CTRL+HOME : will jump the editor to the start of the program  
CTRL+END : will jump the editor to the end of the program 
PAGE UP/PAGE DOWN : will scroll the editor up or down by the number of lines shown at any one 
time. 
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 The Fast Editor Menu  

 

  

Fast Editor Menu 

This editor is a 'cut' down editor which improves machining performance using large CNC files. 
A full-blown editor is still available and can be selected from the File Menu -> 

  

  

 

The Edit menu is only available when the "Editor" window is active. To activate the window, click on the 
title bar at the top to select it as shown in red below. 

 

Undo (CTRL-Z) will undo the previous edit command. Over 500 edits are stored and can be undone.
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Find (CTRL-F) will find an item of text within the editor 

Replace (CTRL-R) will replace any item of text with another, eg, Replace all "F1000" with "F500" 

Preferences... Colour Scheme... allows you to select a different color scheme for the editor, from preset 
colour combinations 

   

 

 The Fast Editor Window  

 

  

 

The Editor Window - Page 1 of 3 

General Layout 

The "Editor" window is used for viewing and editing the text content of the CNC file.  The Editor is also 
the main window used when CNC files are entered in MDI (Manual Data Input) mode. 

 

The titlebar of the "Editor" window displays the name and location of the currently loaded CNC file, 
circled yellow in the example above. 

The editor text display panel shows the content of the CNC file,listed line by line from the top to bottom. 

The statusbar of the "Editor" window displays the editor panel line and column numbers relating to the 
position of the cursor.  In the example above, the cursor (highlighted green) is at column position 9, on 
text line 6 (circled red). 

Note:  Do not confuse the editor text line number with the CNC file (N address) number. 
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The Editor Window - Page 2 of 3  

Editing text in the CNC File 

Sections of the CNC file can be changed by using the "Editor " window as a simple word processor. 

Positioning the "Editor" window cursor 

 

The "Editor" window cursor is a flashing vertical black line, shown circled red in the above screenshot.  
This cursor shows where characters can currently be inserted, removed or highlighted.  To remove 
characters directly behind the "Editor" window cursor, press the [Delete] key.  To create a new CNC file 
line, press the [Enter/Return] key. 

The mouse positioning cursor is a vertical black line with bars at its top and bottom, shown circled yellow 
in the above screenshot.  This cursor is used to move the "Editor" window cursor to new positions in the 
CNC file. 

To reposition the cursor in the "Editor" window: 

Position the mouse positioning cursor in the required area, then click the left mouse button to move. 

Use the four computer [Cursor] arrow keys to move the "Editor" window cursor to the required position. 

Use the [Page Up] key to move to the top of the CNC file. 

Use the [Page Down] key to move to the bottom of the CNC file. 

Use the [Home] key to move to the beginning of the current CNC file line. 

Use the [End] key to move to the end of the current CNC file line.
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Selecting and editing areas of text 

 

To select areas of text in the "Editor" window, position the "Editor" window cursor (the vertical black 
line) at the start or end of the text required, then click and hold down the left mouse button.  Drag over the 
required characters to highlight them, as shown above.  To select all the text in the "Editor" window use 
the "Select All" option from the "Edit" menu. 

The highlighted characters can be edited using the following commands: 

Select the "Cut" option from the "Edit" menu to cut any highlighted text from the "Editor" window to the 
Windows clipboard.  Computer keyboard shortcut: [CTRL + X] 

Select the "Copy" option from the "Edit" menu to copy any highlighted text from the "Editor" window to 
the Windows clipboard.  Computer keyboard shortcut: [CTRL + C] 

Select the "Paste" option from the "Edit" menu to place any text held in the Windows clipboard to the 
current "Editor" window cursor position.  Computer keyboard shortcut: [CTRL + V] 

Select the "Undo" option from the "Edit" menu to undo the last command performed in the "Editor" 
window. 

Select the "Redo" option from the "Edit" menu to repeat the last command performed in the "Editor" 
window. 

 

 The Editor Menu (colour highlighting areas of text)  
 The Edit Menu (manipulation of text)  
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The Editor Window - Page 3 of 3 

Formatting editor text between CAPITALS and lowercase 

     

Select the "Change to UpperCase" option from the "Modify" menu to change any highlighted characters 
in the "Editor" window to CAPITALS, as shown above left. 

Select the "Change to LowerCase" option from the "Modify" menu to change any highlighted characters 
in the "Editor" window to lowercase, as shown above right. 

Adding spaces between CNC program words 

     

Select the "Add Padding Token" option from the "Modify" menu to add a specified number of spaces 
between program words.  In the example above, the left screen shows no additional padding, whilst the 
right screenshot shows a padding of 3 spaces. 

Select the "Remove Padding Token" option from the "Modify" menu to remove a specified number of 
spaces between program words. 

Adding Line End Formatting 
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Select the "Append Line End Token" option from the "Modify" menu to add line end formatting to 
program lines.  In the example above, the left screen shows no line end formatting, whilst the right 
screenshot uses the ; character as the line end token. 

Select the "Remove Line End Token" option from the "Modify" menu to remove line end formatting from 
program lines. 

Adding Line Numbers to CNC program lines 

     

Select the "Line Numbering..." option from the "Modify" menu to add or remove program line numbers to 
or from the beginning of each program line.  In the example above, the left screen shows no program line 
numbering, whilst the right screenshot shows program numbers signified by the N address letter. 

 

 The Modify Menu  
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2D - 3D Simulation - Page 1 of 4 

To open the simulation window click on the 2D/3D simulation button.  

 

The window displays a virtual billet, which is displayed in 3D mode. However, you can switch to the 2D 
mode by clicking the 2D button and back to the 3D mode again with the 3D button .  

Simulation options bar 

 

The simulation options bar shown here situated at the top of the window allows you to quickly change 
various display settings by clicking on the buttons. Note: the options bar can be switched off as 
determined by the settings in the "Simulation | Options | Show options as buttons" menu. 

Information bar 
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Information about various parameters are displayed at the bottom of the window. When the program is 
run, the information displayed is updated as each line is executed. A description of each parameter is 
shown below. 

 

 Running a 3D simulation  

 

  

 

3D Simulation - Page 2 of 4 

Using the mouse to zoom and pan 

Place your mouse cursor in the centre of the 3D simulation viewing area. Click and hold down the 
appropriate mouse button and drag it around the screen : 
 
Left mouse button : Rotates the part, either left or right. 

Right mouse button : Zooms in and out of the part. 

 

 The simulation window  
 Running a 3D simulation  
 Simulation options bar  
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2D Simulation - Page 3 of 4  

 

How to zoom in and out of the part 

Click the cursor at the central focus point of your zoom position and then drag to the side. 

Right click and drag to pan the part around the window. 

Click the zoom-to-fit to return back to the original view. 

- Changes to the 3D simulation mode 

- Changes to the 2D section view mode 

 - Go to CNC line button. The selected line or arc of the toolpath is highlighted in the CNC editor 

window by flashing three times. 
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Note: This function is not available in the 3D mode. 

 

  

 

2D Section View - Page 4 of 4 

The section view mode displays a top view in the top left, a front elevated view at the bottom and a side 
elevated view to the right. 
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The front and side views show a slice taken at the position of the crosshairs on the top view. To change 
the location of the crosshairs, position the cursor at the intersection point, click and release the left mouse 
button, drag the crosshairs to the new position and then click and release the left mouse button again. A 
section view will now be displayed.  

Note: The front and side views will not be updated until a simulation has finished running. 

Co-ordinates 

 

The XYZ co-ordinates of the cross-hairs intersection point are displayed at the bottom of the screen. To 
examine the part, including the depth of cut at any point, click and release the mouse button at the 
intersection point. The co-ordinates are displayed as you drag the cursor around the part. 

 

  

 

Tool and Offsets Editor - Page 1 of 4 

Page 12 of 40

15/12/2010



Before you run the Simulation or VR Machine you should "tell" the software which tool type you are 
using. This is done using the "Tool and Offset Editor". The button for this is usually found at the bottom 
of the screen as shown below. 

 

Tool and Offset Editor 

Click the  to activate the editor. 

 

The "Work Offsets" section stores the position of the workpiece datum. 

The "Tooling Data" section stores the individual length offsets for the tools. 

The "Tool Library" section contains a list of tools available to the user. Tools can be added, removed or 
modified from the list. All the information held in the 'Tool and Offsets Editor' is saved in a file. (the 
filename is displayed at the bottom of the window). You can create, edit and delete your own offset files.
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Work Offsets - Page 2 of 4  

 

The values displayed for each axes is the distance from machine home position to the workpiece datum 
position. 

To set the X axes click the  button. 

To set the Y axes click the  button. 

To set the Z axes click the  button. 

To set all the axes at once click the  button. 

Here you can see a list of offset descriptions. You can add, delete, copy and paste offsets by using the 
right click pop up menu 

IMPORTANT : Before you run your CNC program always check that the correct offset is activated. To 
activate the offset you can either: 

 Right click on the offset description and select "Activate" from the pop up menu  
 Select the offset and then click  .  

Create a new work offset 

It is often the case that you may find yourself using a particular material and tool to do a certain job. In 
this case you can use this facility to create a new offset and add it to the list. 

1. Click the new workoffset button.   

2. Click on the 'blank' offset that has been added to the list to select it.  
3. Type in a description for your new offset.  

Alternatively : 
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1. Right click on the ‘Description’ panel.  
2. Select "Create Offset" from the pop up menu.  
3. Click on the 'blank' offset that has been added to the list to select it.  
4. Type in a description for your new offset.  

Delete current selection 

To delete an offset you can either: 

 Select the offset and click the Delete current selection   

 Right click on the offset description and select "Delete Offset" from the pop up menu 

The offsets mode 

 

The machine mode is displayed at the bottom of the window and is either 'Machine: Virtual' or 'Machine: 
Real'. A different set of offsets are used depending on which mode you are in. 

If the VR simulation window is open, then the 'Virtual' offsets are activated. These will only affect the 
Virtual Reality Simulation and must not be confused with the 'Real' offsets. 

The software is in 'Real' mode whenever the VR simulation window is not enabled. Changing values in 
this mode will affect the offsets on the real machine! 

 

 What are Offsets?  
 The Machine Datum  
 Types of Offset  
 Configuring Offsets when using only one Tool  
 The Program Information window  
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Tooling Data - Page 3 of 4 

 

Each tool used in your CNC program must be defined here. Failing to do so will cause an error message 
when running a simulation. 
The length and diameter of the tools shown in the VR, 3D and 2D simulations are taken from this table. 

Adding a new tool to the list 

A new tool can be added to the list by: 

a) selecting a blank tool in the list then entering all the values for that tool in the right hand 
section of the window. Note: a new tool created here can be added to the 'Tool Library' by 

clicking the or by right clicking on the tool and selecting "Save tool to Library" from 

the pop up menu. 
b) selecting one of the pre-defined tools in the 'Tool Library'. This can be done by clicking the 

or by right clicking on a blank tool and selecting "Insert Library Tool" from the pop up 

menu. 

Tooling information: 

Diameter - the diameter of the tool 

Tool offset - Each tool in the list contains a Tool offset (Z) value. When all the tools are exactly the same 
length, this value is the same for all tools. However, when tools vary in length, their relative differences 
are stored here. 
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Type- tool type choices are : Slot Mill, End Mill, Ball Nose, Slab Mill, Drill, Centre Drill and Engraving.
Note: Tools defined as a Tapered, Dove Tail and a T Slot will only be represented in the simulation as a 
Slot Mill. Tools defined as type UnDefined will not be shown in the simulation at all. 

Length - Total length of the tool (shank length + flute length) 

Flute length - Length of the flutes (cutting edge) 

 

 

  

 

Tool Library - Page 4 of 4 
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The 'Tool Library' contains a list of predefined tools, which can be used in the Tooling Data list. 

To edit the data for the tool, click on the relevant parameter and an input menu will automatically appear 
giving you the options available. 
 
Create a new tool definition in the library 

Click to add a new tool to the tool library. 

Delete currently selected tool  

Click on a tool and then click the delete tool button. 
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2D - 3D - VR Simulation - Page 1 of 5 

To enter the Virtual Reality world click on the VR machine button  

 

When running in VR Machine Mode, the "Denford Virtual Reality" window is used to display a three 
dimensional representation of the CNC machine. This VR machine is driven and responds in exactly the 
same way as its real-life counterpart, making the VR Machine Mode ideal for offline CNC training.  

Navigation bar 

 

Use these buttons to move around the VR world. Click here for more information. 
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Interacting with the world 

Some of the functionality of the models can be achieved by clicking on the relevant objects. 

 Left click on the handle to open and close the guard. 
 Left click on the red button on the front of the machine to add/remove the cabinet (for a better view 

inside the machine). 
 Billet Position – Hold down the left [SHIFT] + left mouse button on the virtual billet to drag it to a 

new position on the machine table. The X and Y co-ordinates of the billet are displayed at the 
bottom of the VR – 3D – 2D window. These co-ordinates refer to the distance from the front left 
hand corner of the machine table to the front left hand corner of the billet. The size and position can 
be changed in the "Simulation | Default Billet Size" menu. 

  

Options Bar 

 

The options bar menu allows you to customise the settings within the virtual world. 

 

  

 

Navigating around the VR World - Page 2 of 5 

Navigation bar 

 

Use these buttons to move around the VR world. Click here for more information. 

The movebar tools allow you to freely 'fly' around the virtual world. Try to think of the display in the 
Main Viewing Area as being the view from a floating camera head, which you can control using the three 
movement icons. Each icon is used to control a different type of movement in the virtual world. 
 

 : The view will rotate as if you were moving your head but standing in a stationary position. 

 : Moves the viewpoint as if you were walking around, forwards and backwards. 
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 : Moves the viewpoint as if you were moving in a vertical plane. Up, down, left and right only. 

 
Click and hold the left mouse button on one of the three movement icons, then drag the mouse. As you 
drag the mouse the icon indicates the direction you are moving, and the viewpoint moves in the 
corresponding direction. The further you move the cursor from the icon, the faster you will move. Release 
the mouse button to stop the movement. 
 
Using the mouse cursor to move around the Virtual Reality world 

You can also navigate around the world by placing the mouse cursor inside the VR viewing area. 
 
Left mouse button : The view will rotate as if you were moving your head but standing in a stationary 
position. 

Right mouse button : Moves the viewpoint as if you were walking around, forwards and backwards. 

Left and Right mouse buttons together : Moves the viewpoint as if you were moving in a vertical plane. 
Up, down, left and right only. 

[CTRL] + Left mouse button : Tilts the virtual world in the direction of the mouse movement. 
 
The mouse sensitivity (navigation speed) is defined in the "Simulation | Navigation Setting" menu 

 

Graphical Information... 

 

  

 

The VR Options Bar - Page 3 of 5 

 

 Tool Path - Displays a colour-coded path of all tool movements. The different colours represented 
by the simulation are defined in the "Lines" section of the "Simulation | Billet Materials " menu. The start 
XYZ co-ordinate and end XYZ co-ordinate of the selected line/arc is displayed at the bottom of the 
screen. Note: The facility to select elements of the tool path is not available in the 3D or VR modes. 
 

Hide Billet - Speeds up the simulation by replacing the 3D graphic image of the billet with a simple 
wire frame. 
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Swarf - Animated particles of material are shown as the cutter removes material. 
 

Datum - Shows a datum symbol at the position specified in the "Simulation | Datum Position…" 
menu. Cross hairs are also displayed at the tool tip. 

 
 

Sound - Produces sounds of rapid movements and cutting movements during the simulation. 
 

Overrides - Displays Feedrate and Override dials in the simulation window. Note: Although the 
position of the dials can be changed with the mouse, they will have no affect on the speed of the cutter in 
the 2D/3D simulation mode. 
 

Light - Shows a representation of the position of the light source. To change the light source position, 
click and drag the sphere and then release. Right click on the sphere to reset the light source back to the 
default position. 
 

The camera views toolbar.  

 

  

 

Camera Views Page - Page 4 of 5 

 

 

This feature allows you to move around the simulation to a desired position and store it in a button. You 
can then jump back to that position by clicking on the button again. There are 8 camera views available. 
 

 - currently active camera 
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 - camera position defined 

 - camera position undefined (empty) 
 
How to select a pre-defined camera position 

Click on any  to jump to the view. Note: Hovering over the button displays a description. 
 
How to add a new camera position 

Move to (navigate) to the new position (view). 

Right click on an empty camera button.  

Select "Set Position" from the pop-up menu. 

Type in a name describing your new position (optional) and press [OK] or [Enter] to store. 
 
How to delete a camera view 

Right click on a pre-defined view or current view and select "Clear Position" from the pop-up menu. 
 
How to edit the description of a camera view 

Right click on a pre-defined view  or current view  and select "Edit Name" from the pop-up 
menu. 

 

 Navigating around the VR world  
 The 3D simulation window  

 

  

 

VR Settings Page - Page 5 of 5 

Jog Speed 

Jog speed - this is determined by both the position of the dial in the Control Panel and the Feed override 
pots in the VR window (if switched on). 
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Collision Detection 

When the cutter collides with a machine component, it will change colour. This is particularly useful 
when setting the tool offsets.  

Note: The colour is specified in the "Simulation | Billet Materials" menu 

A collision with the billet is detected only if the cutter is stopped. A rotating cutter will not be classed as a 
collision, but a valid cut, and so will not change colour. 

Auto Datum 

The work piece and tool length offsets must always be configured correctly on the real machine. 
However, if you just want to run the VR simulation without having to set the offsets, the Auto Datum 
facility can be used. 

When the Auto Datum is off - the workpiece and tool length offsets must be set in the same way as the 
real machine. 

When the Auto Datum is on - The current workpiece and tool length offsets are ignored and the work 
piece datum will be taken from the settings specified in the "Simulation | Datum Position" menu.  

Base Type 

To add a base or specify its height, go to the "Simulate | Base Type" menu. 

Work Holder 

Various work clamps can be added to the virtual machine table to simulate the work holding of the billet. 
To add a work holder go to the "Simulate | Work Holder" menu. 

  

 

  

  

The Control Panel Window - Page 1 of 6  

The "Control Panel" window is displayed when either the VR Machine or Real CNC Machine is active. 

To start the VR Machine, click the [VR Machine]  button.  

To start a 'real' CNC Machine attached to the computer, click the [Machine]  button.  
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General Layout 

The "Control Panel" window is used for controlling the movements of the machine. 

 

The "Control Panel" window contains three tabs, shown highlighted by the red box in the above 
screenshot: 

Home:  Home Mode, used for configuring the machine, before it can be fully used.  This finds the 
Machine Datum and limits of co-ordinate movement. 

Jog:  Jog Mode, used for manually moving the machine within its co-ordinate envelope. 

Auto:  Auto Mode, used for controlling the machine with a CNC file. 

Note:  The "Jog" and "Auto" tabs will not be displayed until the machine has been configured by homing 
all of the three axes. 

The statusbar, highlighted by the yellow box in the above screenshot, is positioned at the bottom of the 
"Control Panel" window.  It displays the following information, listed from left to right: 

The last programmed Feedrate setting:  Denoted by "F" and a numerical value.  When the [Units] of 
Measurement are set to "Inch" the feedrate is measured using inches per minute.  When the [Units] of 
Measurement are set to "Metric" the feedrate is measured using millimetres per minute. 

The last programmed Spindle Speed setting:  Denoted by "S" and a numerical value.  The spindle speed
is measured using revolutions per minute. 

The last programmed Tool Change:  Denoted by "Tool" and the number of the tool. 

 This icon may be displayed in the Control Panel window next to a particular axis position readout. It 
means that the axis is currently at its positive limit of travel.
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 This icon means that the axis is at its most negative travel. 

  

 

  

  

The Control Panel Window - Page 2 of 6  

Home Mode 

Note:  The numerical figures depicted on screenshots will differ according to the CNC machine and 
offsets being used on your computer system. 

 

The "Home" tab is used for configuring the machine before it can be fully used.  This defines the Machine 
Datum, used as a zero reference for describing all co-ordinate positions and defines the limits of co-
ordinate movement for the machine. 

Click here for more about the Theory behind Homing the Machine and the Machine Datum 

Note:  The "Jog" and "Auto" tabs will not be displayed until the machine has been configured by homing 
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all of the three axes. 

To configure the machine X axis only, click the [X Axis ONLY] button.  The X machine slide will move 
until it has found its limits of co-ordinate movement. 

To configure the machine Y axis only, click the [Y Axis ONLY] button.  The Y machine slide will move 
until it has found its limits of co-ordinate movement. 

To configure the machine Z axis only, click the [Z Axis ONLY] button.  The Z machine slide will move 
until it has found its limits of co-ordinate movement. 

To configure all three axes together, click the [All Axes] button.  All machine slides will move until the 
limits of co-ordinate movement have been found. 

Co-ordinate System Display Mode 

The [Co-ordinates] button is used to switch between the two systems used for displaying the co-ordinate 
positions.  The far right panel on the statusbar, at the bottom of the "Control Panel" window, displays the 
current setting for this button.  When the [Units] of Measurement are set to "Inch" the co-ordinates are 
displayed using inches.  When the [Units] of Measurement are set to "Metric" the co-ordinates are 
displayed using millimetres. 

Click here for more about the Theory behind Co-ordinate System Display Modes 

Work Piece Co-ordinates System  

This system displays the co-ordinate position relative to the moveable workpiece datum.  When the Co-
ordinate System Display Mode is set to Program Position, the button graphic shows the X,Y,Z symbol 
with a picture of the work piece (billet).   

 

   

Machine Co-ordinates System   

This system displays the co-ordinate position relative to the fixed machine datum.  When the Co-ordinate 
System Display Mode is set to Machine Position, the button graphic shows the X,Y,Z symbol with a 
picture of the machine head and table.  
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The Control Panel Window - Page 3 of 6  

Jog Mode (Part 1 of 2) 

 

The "Jog" tab is used for manually moving the machine within its co-ordinate working envelope. 

Jog Control Modes 

The "Jog" panel displays the [Jog] button, a dial and the jog control value.  The machine table and head 
can be jogged, or moved, using two different methods.  To change between these two methods, click the 
[Jog] button.  To change the jog control value, click and hold down the left mouse button on the dial, then 
drag the cursor up or down to the new position.  When the [Units] of Measurement are set to "Inch" the 
rate of movement is measured using inches per minute.  When the [Units] of Measurement are set to 
"Metric" the rate of movement is measured using millimetres per minute. 

Jog Continuous:  In jog continuous mode, the selected machine axis will move at the indicated speed 
when one of the machine axis movement keys are pressed and held down.  The selected machine axis will 
continue to move until the key is released.  When Jog Continuous is active, the [Jog] button graphic will 
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be displayed as shown below. 

 

Jog Step:  In jog step mode, the selected machine axis will move one indicated increment, each time the 
selected axis movement key is pressed.  The dial can be moved to pre-set jog increments. Note: on some 
CNC Machines the smallest jog setting maybe too small for the machine to move at all. In this case select 
a larger step value. When Jog Step is active, the [Jog] button graphic will be displayed as shown below. 

 

Jog Control Movement Keys 

In order for the Jog Keys to work, the control panel must be the active window on the screen. Clicking 
anywhere on the control panel window makes it the active window. A green light on the panel indicates 
that it is currently active as shown below. 

 

To move the X machine axis use the [Left Cursor] and [Right Cursor] arrow keys. 

To move the Y machine axis use the [Up Cursor] and [Down Cursor] arrow keys. 

To move the Z machine axis use the [Page Up] and [Page Down] keys. 

 

  

  

The Control Panel Window - Page 4 of 6  

Jog Mode (Part 2 of 2) 

The "Jog" tab is used for manually moving the machine within its co-ordinate envelope. 

Spindle Speed Control 
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The "Spindle" panel displays the [Spindle] button, a dial and the numerical spindle speed value.  To 
change the spindle speed value, click and hold down the left mouse button on the dial, then drag the cursor 
up or down to the new position. Note: Double clicking on the dial sets it to the vertical position. 

 

The spindle speed setting is also displayed in the "Control Panel" window statusbar, using the "S" address 
letter.  The spindle speed is measured using revolutions per minute. 

You can manually start and stop the spindle with the following Control Panel button:  

 

Click once to start the spindle, click again to stop it. You can also activate the appropriate m code (3,4 or 5) to start or stop the 
spindle, from the m-code menu: 

M Codes 

Click the [M Codes] button to display the list of M codes, shown below.  Move the cursor down the list to 
highlight the options.  Click the highlighted option to select it.  For detailed information regarding M code 
Programming, click "Help | CNC Programming" to display the "Denford CNC Programming for Milling 
Machines" helpfile. 

 

Coolant 

Click the [Coolant] button to manually switch the coolant pump (when fitted to the machine) on and off. 

Coolant Off:  When the coolant pump is not running, the graphic below is displayed on the button: 

 

Coolant On:  When the coolant pump is running, the graphic below is displayed on the button: 
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The Control Panel Window - Page 5 of 6  

Auto Mode (Part 1 of 2) 

Note:  The numerical figures depicted on screenshots may differ according to the CNC machine and 
offsets being used on your computer system. 

 

The "Auto" tab is used for controlling the machine with a CNC file. 

Feedrate Control 

The "Feed" panel displays a dial and the current feedrate override, displayed as a percentage.  Override 
values between 1-100% are set in the lower green portion of the slider bar.  Override values between 100-
150% are set in the upper red portion of the slider bar.  The last programmed feedrate setting is displayed 
in the "Control Panel" window statusbar, using the "F" address letter. 

To change the feedrate value, click and hold down the left mouse button on the slider bar, then drag the 
slider bar up or down to the new position. 

When the [Units] of Measurement are set to "Inch" the feedrate is measured using inches per minute.  
When the [Units] of Measurement are set to "Metric" the feedrate is measured using millimetres per 
minute. 
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When potentiometer controls are fitted to the CNC machine, allowing manual override of the feedrate, the 
control panel will be disabled as shown below. 

 

Spindle Speed Control 

The "Spindle" panel displays a dial and the current spindle speed override, displayed as a percentage.  
Override values between 50-100% are set in the lower green portion of the slider bar.  Override values 
between 100-120% are set in the upper red portion of the slider bar.  The last programmed spindle speed 
setting is displayed in the "Control Panel" window statusbar, using the "S" address letter. 

To change the spindle speed value, click and hold down the left mouse button on the dial, then drag the 
cursor up or down to the new position. 

The spindle speed is measured using revolutions per minute. 

When potentiometer controls are fitted to the CNC machine, allowing manual override of the spindle 
speed, the control panel will be disabled as shown below. 

 

 

  

  

The Control Panel Window - Page 6 of 6  

Auto Mode (Part 2 of 2) 

The "Auto" tab is used for controlling the machine with a CNC file. 

Turbo Mode 

Click the [Turbo Mode] button to switch Turbo Mode on. This can be done at any time, even when the 
program is running. The 'turbo mode' feature has been developed to reduce the machining times of large 
3D programs and complex 2D programs. For larger programs E.G. more than 100 lines, turbo mode on 
will usually make the machine perform with a smoother motion. It is recommended that programs 
produced from 3D CAD/CAM software are run with turbo mode on. 

Turbo Mode Off:  When Turbo Mode is inactive, the graphic below is displayed on the button: 
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Turbo Mode On:  When Turbo Mode is active, the graphic below is displayed on the button: 

 

What is turbo mode? 

When a CNC file is run, the first block of the CNC file is sent from your computer to the controller card in 
your CNC machine.  At this point, the computer will pause until return data is received from the CNC 
machine.  The CNC machine controller card interprets the data and instructs the CNC machine on the 
necessary actions to perform, for example, co-ordinate movements, cutting operations, tool changes etc.  
When the instructions have been completed, data is returned to the computer to update information panels 
in the software, such as the co-ordinate position of the machine head.  The following CNC file block is 
then sent to the CNC machine.  This sequence continues until the CNC file is completed. 

When Turbo Mode is switched on, the computer does not wait for return data to be sent back from the 
CNC machine, before sending the next block of the CNC file.  This allows the CNC file to be completed 
faster, but areas of the software such as the co-ordinate display panel, will not be continuously updated. 

Material Override 

The [Material Override] button automatically adjusts the feedrate and spindle speeds for 

different materials as defined in the Materials Editor. 

 

Conventionally, the feedrate and spindle speeds of the cutter are programmed from values within the CNC 
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program. However, the [Material Override] button, allows these values to be replaced with those defined 
in the materials table. 

Caution - This facility should be used with care as selecting an inappropriate setting for your material 
could damage the cutter.  

1. To activate the material override facility, click the button.  

2. To select a different material use the"Choose Material" drop down menu. The Feedrate and Spindle 
Speed values for the active material settings are displayed. 

 

To deactivate the material override and revert back to feeds and speeds from the CNC program, click the 

button again .  

The list of materials can be edited using the "Setup | Materials | Edit Materials" menu. To find out more 
click here. 

Co-ordinate System Display Mode 

The [Co-ordinates] button is used to switch between the two systems used for displaying the co-ordinate 
positions.  The far right panel on the statusbar, at the bottom of the "Control Panel" window, displays the 
current setting for this button.  When the [Units] of Measurement are set to "Inch" the co-ordinates are 
displayed using inches.  When the [Units] of Measurement are set to "Metric" the co-ordinates are 
displayed using millimetres. 

Click here for more about the Theory behind Co-ordinate System Display Modes 

Work Piece Co-ordinates System:  This system displays the co-ordinate position relative to the 
moveable workpiece datum.  When the Co-ordinate System Display Mode is set to Program Position, the 
button graphic shows the X,Y,Z symbol with a picture of the work piece (billet).   

 

   

Machine Co-ordinates System:  This system displays the co-ordinate position relative to the fixed 
machine datum.  When the Co-ordinate System Display Mode is set to Machine Position, the button 
graphic shows the X,Y,Z symbol with a picture of the machine head and table.  
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Coolant 

Click the [Coolant] button to manually switch the coolant pump (when fitted to the machine) on and off. 
Switching on the coolant manually will override coolant on/off commands within the CNC program. 

Coolant Off:  When the coolant pump is not running, the graphic below is displayed on the button: 

 

Coolant On:  When the coolant pump is running, the graphic below is displayed on the button: 

 

 

  

 

Program Information - Page 1 of 2 

Program Information window 

The button for this utility is found in the option toolbar usually at the bottom of the screen as shown 
below. 
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Click the button to open the information window. Clicking the button again also closes the 

window. 

The toolpath shown in the window is a representation of the current CNC program in the editor. It can be 
used as a quick preview of the cnc program or as an alternative to the 2D / 3D simulation, which can take 
longer to complete. It is also a useful tool when trying to resolve machining problems e.g. 'Machine 
Exceeds Limits' errors 

 

Refresh - click this button if your CNC program or your tool offsets have changed and the screen 

needs updating. 
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Toggle tool length offsets on/off : 

When switched on: the Z length values of the individual tools, set in the Tooling Data section 
of the Tool and Offsets editor are included when calculating the Z height of the tool path. 

When switch off: the Z length values of the individual tools, set in the Tooling Data section 
of the Tool and Offsets editor are ignored when calculating the Z height of the tool path. 

The advanced button located here displays additional information in a dockable 

toolbar shown here at the bottom of the window. 

 

Billet: The dimensions of the billet as defined in the menu “Setup | Default Billet Size…” or by the 
[BILLET definition in the CNC program. 

Tools Used: Indicates the tools used in the order they appear in the cnc program.  

Max Move: The largest values reached for the X,Y and Z positions and the fastest programmed feedrate.

Min Move: The smallest values reached for the X,Y and Z positions and the slowest programmed 
feedrate. 

This table indicates which colours are used for the toolpath in the order they are displayed in the 
information toolbar. The actual colours shown are the default colours used when the software is installed. 
To change the colours, left click on the coloured square and pick a new colour from the pop-up grid 
displayed. 

 

Colour Key:
rapid move 
(G00/28)

linear move 
(G01)

circular 
move (G02/3)

toolchange 
move

move exceeds 
limits 
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 The CNC Machine Working Envelope  
 'Machine Exceeds Limits' error  
 Program Pre-Scan  

 

  

 

Program Information - Page 2 of 2 

Machine movement error ! 

 

Example of a toolpath with an 'exceeds limits' problem. 

In this example, part of the toolpath is displayed outside the CNC machine working envelope causing an 
error. 

Whenever an error is detected, a window appears on the screen similar to the one shown below. 

Page 38 of 40

15/12/2010



This window appears if the CNC program is attempting to move to a position outside the cutting area of 
the machine. The window displays the first line in the CNC program that contains the 'over travel' 
movement and by how much. There are basically two reasons why this could happen: 

a) The workpiece and or tool length offsets are inappropriate for the program.  
b) The overall size of the component you are trying to machine is too large for the CNC 
machine working envelope 

There is a problem with the above example because the billet is positioned too far over to the right. We 
need to re-position the billet nearer to the left hand corner of the machine table and redefine the offsets. 

The X offset value must be changed in the tools and offsets editor.  

 

The "Machine movement error" window will disappear as soon as there is a valid X offset in the editor. 

 

Example of a toolpath that is larger than the CNC machine working envelope. 

 

In this example the design is too big to fit inside the working envelope of the machine. The billet is 
already positioned towards the front of the table but is giving overtravel errors at the top of the design. 
The only solution would be to scale down your design or use a machine with a larger working envelope.
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 Error messages  
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How to use the Tutorials  

The tutorials section is designed as a full course, helping you to start using all the different features 
in the VR CNC Milling software. 

The tutorials are divided into six sections: 

1: Tutorials Introduction 

2: Working with CNC files 

3: Running Simulations 

4: Using a Virtual Reality CNC Machine 

5: Using a real CNC Machine 

There are two courses to follow.  If you are new to using the VR CNC Milling software, we 
recommend that you follow one of the courses from start to finish.  Each full course should take 
around 1 hour to complete. 

Virtual Reality Course:  This course is designed for users intending to use the software offline, ie, 
with a Virtual reality CNC machine. Follow tutorials 1, 2, 3 and 4. 

Real CNC Machine Course:  This course is designed for users intending to use the software online, 
ie, with a real CNC machine. Follow tutorials 1, 2, 3 and 5. 

 

  

  

Using Menubars and Toolbars  

Part 1: Toolbars 

The various toolbars in the software can be repositioned to form different screen layouts, as required.

Note - Only toolbars can be docked and undocked.  Any windows appearing through use of the 
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toolbar buttons can only be displayed in the main software window.

If you are unsure about the function of any toolbar button, hover your mouse cursor over the button 
to display a pop-up hint caption. 

Docked Toolbar Example: 

 

A docked toolbar can be positioned anywhere on the main software window docking bars.  Docking 
bars are provided on the top, left-hand and bottom grey border edges of the main software window.  
To move a docked toolbar click and hold your left mouse button on the two grey lines at the end of 
the toolbar, circled red in the screenshot above.  Drag the toolbar to the new position and release the 
mouse button.  To undock a toolbar, drag it off the window docking bar into the main software 
window, then release the mouse button. 

Undocked Toolbar Example: 

 

An undocked toolbar can be positioned anywhere in the main software window.  To move an 
undocked toolbar click and hold your left mouse button on the toolbar titlebar, circled red in the 
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screenshot above.  Drag the toolbar to the new position and release the mouse button.  To dock a 
toolbar drag and position it over one of the grey border edges of the main software window. 

  

 

  

Context Sensitive Help  

What is Context Sensitive Help? 

At the press of a key, context sensitive help automatically guides you to the appropriate sections of 
helpfiles, whenever you need help with various parts of the software.  Context sensitive help is 
available for the following items: 

Menu:  To obtain context sensitive help on a software menu, click the menu title to display its 
dropdown list of options, then press the [F1] key. 

Click here for more about Context Sensitive Menu Help 

Window:  To obtain context sensitive help on a software window, press the [F1] key when the 
required window is active. 

Click here for more about Context Sensitive Window Help 

G and M codes:  To obtain context sensitive help on an individual G or M code, position the 
"Editor" window cursor in the middle of the text for the code required, then press the [Ctrl + F1] 
keys. 

Click here for more about Context Sensitive G and M code Help 

Available Helpfiles 

The VR CNC Milling software contains two separate helpfiles, both available from the "Help" menu 
title. 

VR CNC Milling:  The VR CNC Milling for Windows software helpfile (the helpfile currently 
being viewed).  This helpfile contains VR CNC Milling tutorials, detailed information about the 
various features of the VR CNC Milling software, troubleshooting guides and a guide to CNC 
Theory. 

CNC Programming:  The CNC Milling Programming helpfile.  This helpfile contains detailed 
information about individual G and M codes and structure of CNC files. 
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Sample CNC file - Metric version  

The CNC file shown below is used throughout this series of tutorials: 

Below: 3D simulation of the metric (millimetres) sample CNC file. 

 

Billet: High Density Polystyrene 
Part Datum Position: Top left-hand front corner of proposed billet 
Dimensions: X (length) 60mm, Y (width) 60mm, Z (height) 2mm 
Tools required: 
2mm slot cutter (cutting 2mm deep) 

4mm slot cutter (cutting 1mm deep) 

Metric (millimetres) sample CNC file with no formatting: 

Check that the units of measurement are set to "Metric".  The units of measurement are configured 
using the [Units] button on the "Options" toolbar. 

Copy and paste the CNC file listed below into a new (blank) "Editor" window. 
Save the CNC file as "Metric.fnc". 
   
G21 
[BILLET X60 Y60 Z10 
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[EDGEMOVE X0 Y0 
[TOOLDEF T1 D4 
[TOOLDEF T2 D2 
G91G28X0Y0Z0 
M6T1 
G43H1 
M3S1500 
G90G0X20Y40 
Z2 
G1Z-1F100 
Y20F150 
X40 
Y40 
X20 
G0Z2 
M5 
G91G28X0Y0Z0 
M6T2 
G43H2 
M3S1500 
G90G0X5Y55 
Z2 
G1Z-2F100 
X40F150 
G2X55Y40J-15 
G1Y5 
X20 
G3X5Y20I-15 
G1Y55 
G0Z2 
M5 
G91G28X0Y0Z0 
M30 
  

Metric (millimetres) sample CNC file with full formatting: 

Check that the units of measurement are set to "Metric".  The units of measurement are configured 
using the [Units] button on the "Options" toolbar. 
Copy and paste the CNC file listed below into a new (blank) "Editor" window. 
Save the CNC file as "Metric.fnc". 
   
N 001 G21 ; 
N 011 [BILLET X60 Y60 Z2 
N 021 [EDGEMOVE X0 Y0 
N 031 [TOOLDEF T1 D4 
N 041 [TOOLDEF T2 D2 
N 051 G91 G28 X0 Y0 Z0 ; 
N 061 M6 T1 ; 
N 071 G43 H1 ; 
N 081 M3 S1500 ; 
N 091 G90 G0 X20 Y40 ; 
N 101 Z2 ; 
N 111 G1 Z-1 F100 ; 
N 121 Y20 F150 ; 
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N 131 X40 ; 
N 141 Y40 ; 
N 151 X20 ; 
N 161 G0 Z2 ; 
N 171 M5 ; 
N 181 G91 G28 X0 Y0 Z0 ; 
N 191 M6 T2 ; 
N 201 G43 H2 ; 
N 211 M3 S1500 ; 
N 221 G90 G0 X5 Y55 ; 
N 231 Z2 ; 
N 241 G1 Z-2 F100 ; 
N 251 X40 F150 ; 
N 261 G2 X55 Y40 J-15 ; 
N 271 G1 Y5 ; 
N 281 X20 ; 
N 291 G3 X5 Y20 I-15 ; 
N 301 G1 Y55 ; 
N 311 G0 Z2 ; 
N 321 M5 ; 
N 331 G91 G28 X0 Y0 Z0 ; 
N 341 M30 ; 

  

 

  

  

Sample CNC file - Metric version  

Explanation of metric (millimetres) sample CNC file: 

N 001 G21 ; (G20 defines the units of measurement being used as metric - millimetres) 

N 011 [BILLET X60 Y60 Z2 (BILLET defines the size of the material being machined, called the 
billet, with X length 60mm, Y width 60mm, Z height 2mm) 

N 021 [EDGEMOVE X0 Y0 (EDGEMOVE defines work datum shift for the program, X0, Y0 
means no shift is applied) 

N 031 [TOOLDEF T1 D4 (TOOLDEF defines tool number 1 with a cutting diameter of 4mm) 

N 041 [TOOLDEF T2 D2 (TOOLDEF defines tool number 2 with a cutting diameter of 2mm)

Page 6 of 56

15/12/2010



N 051 G91 G28 X0 Y0 Z0 ; (G91 instructs the machine to follow incremental movements until told 
otherwise (incremental means all movements are described relative to the co-ordinate position 
achieved in the last program line).  G28X0Y0Z0 moves the cutter to the machine datum via the 
intermediate point indicated) 

N 061 M6 T1 ; (M6 instructs the machine to perform a tool change, if required.  Change to tool 
number 1) 

N 071 G43 H1 ; (G43 instructs the machine to use tool length compensation for tool number 1) 

N 081 M3 S1500 ; (M3 instructs the machine to switch the spindle on clockwise, with a speed of 
1500 rpm) 

N 091 G90 G0 X20 Y40 ; (G90 instructs the machine to follow absolute movements until told 
otherwise (absolute means all movements are described relative to the work datum point).  G0 
instructs the machine to fast traverse to position X20, Y40) 

N 101 Z2 ; (instructs the machine to move the cutter until it is 2mm above the surface of the billet.  
The last G code given was G0 (on the previous line) so the machine will fast traverse to this 
position) 

N 111 G1 Z-1 F100 ; (G1 instructs the machine to cut a straight line from point to point.  Z-1 
instructs the machine to cut 1mm into the material, since Z0 is the surface of the material.  F100 
instructs the machine to use a feedrate of 100mm per minute) 

N 121 Y20 F150 ; (the last G code issued was G1, on line N111.  The cutter will move to position 
Y20, cutting a slot, with a feedrate of 150mm per minute) 

N 131 X40 ; (the last G code issued was G1, on line N111.  The cutter will move to position X40, 
cutting a slot, continuing with a feedrate of 150mm per minute) 

N 141 Y40 ; (the last G code issued was G1, on line N111.  The cutter will move to position Y40, 
cutting a slot, continuing with a feedrate of 150mm per minute) 

N 151 X20 ; (the last G code issued was G1, on line N111.  The cutter will move to position X20, 
cutting a slot, continuing with a feedrate of 150mm per minute.  This finishes the square shape 
etched into the centre of the billet) 

N 161 G0 Z2 ; (G0 instructs the machine to fast traverse to position Z2, moving the cutter 2mm 
above the surface of the billet) 

N 171 M5 ; (M5 instructs the machine to switch off the spindle) 

N 181 G91 G28 X0 Y0 Z0 ; (G91 instructs the machine to follow incremental movements until told 
otherwise (incremental means all movements are described relative to the co-ordinate position 
achieved in the last program line).  G28X0Y0Z0 moves the cutter to the machine datum via the 
intermediate point indicated) 

N 191 M6 T2 ; (M6 instructs the machine to perform a tool change.  Change to tool number 2) 

N 201 G43 H2 ; (G43 instructs the machine to use tool length compensation for tool number 2) 

N 211 M3 S1500 ; (M3 instructs the machine to switch the spindle on clockwise, with a speed of 
1500 rpm) 

Page 7 of 56

15/12/2010



N 221 G90 G0 X5 Y55 ; (G90 instructs the machine to follow absolute movements until told 
otherwise (absolute means all movements are described relative to the work datum point).  G0 
instructs the machine to fast traverse to position X5, Y55) 

N 231 Z2 ; (instructs the machine to move the cutter until it is 2mm above the surface of the billet.  
The last G code given was G0 (on the previous line) so the machine will fast traverse to this 
position) 

N 241 G1 Z-2 F100 ; (G1 instructs the machine to cut a straight line from point to point.  Z-2 
instructs the machine to cut 2mm into the material (cutting completely through the billet) since Z0 is 
the surface of the material.  F100 instructs the machine to use a feedrate of 100mm per minute) 

N 251 X40 F150 ; (the last G code issued was G1, on line N241.  The cutter will move to position 
X40, cutting a slot, with a feedrate of 150mm per minute) 

N 261 G2 X55 Y40 J-15 ; (G2 instructs the machine to cut a clockwise arc.  The arc is cut from the 
position reached in the previous program line to the position X55, Y40.  The centre point of the arc 
is defined by J-15, where J indicates the X axis.  The centre point is -15mm along the X axis from 
the start position of the arc.  The arc is cut with a feedrate of 150mm per minute) 

N 271 G1 Y5 ; (G1 instructs the machine to cut a straight line from point to point.  The cutter will 
move to position Y5, cutting a slot, continuing with a feedrate of 150mm per minute) 

N 281 X20 ; (the last G code issued was G1, on line N271.  The cutter will move to position X20, 
cutting a slot, continuing with a feedrate of 150mm per minute) 

N 291 G3 X5 Y20 I-15 ; (G3 instructs the machine to cut an anticlockwise arc.  The arc is cut from 
the position reached in the previous program line to the position X5, Y20.  The centre point of the 
arc is defined by I-15, where I indicates the Y axis.  The centre point is -15mm along the Y axis from 
the start position of the arc.  The arc is cut with a feedrate of 150mm per minute) 

N 301 G1 Y55 ; (G1 instructs the machine to cut a straight line from point to point.  The cutter will 
move to position Y55, cutting a slot, continuing with a feedrate of 150mm per minute) 

N 311 G0 Z2 ; (G0 instructs the machine to fast traverse to position Z2, moving the cutter 2mm 
above the surface of the billet) 

N 321 M5 ; (M5 instructs the machine to switch off the spindle) 

N 331 G91 G28 X0 Y0 Z0 ; (G91 instructs the machine to follow incremental movements until told 
otherwise (incremental means all movements are described relative to the co-ordinate position 
achieved in the last program line).  G28X0Y0Z0 moves the cutter to the machine datum via the 
intermediate point indicated) 

N 341 M30 ; (M30 defines the end of the program and rewinds back to the start of the CNC file) 
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Sample CNC file - Inch version  

The CNC file shown below is used throughout this series of tutorials: 

Below: 3D simulation of the imperial (inch) sample CNC file. 

 

Billet: High Density Polystyrene 
Part Datum Position: Top lefthand front corner of proposed billet 
Dimensions: X (length) 2.5", Y (width) 2.5", Z (height) 1/8" (0.125) 
Tools required: 
1/8" (0.125) slot cutter (cutting 1/8" (0.125) deep) 

3/16" (0.1875) slot cutter (cutting 1/16" (0.0625) deep) 

Imperial (inches) sample CNC file with no formatting: 
Check that the units of measurement are set to "Inch".  The units of measurement are configured 
using the [Units] button on the "Options" toolbar. 
Copy and paste the CNC file listed below into a new (blank) "Editor" window. 
Save the CNC file as "Inch.fnc". 
   
G20 
[BILLET X2.5 Y2.5 Z0.5 
[EDGEMOVE X0 Y0 
[TOOLDEF T1 D0.1875 
[TOOLDEF T2 D0.125 
G91G28X0Y0Z0 
M6T1 
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G43H1 
M3S1500 
G90G0X0.75Y1.75 
Z0.08 
G1Z-0.0625F3.9 
Y0.75F5.9 
X1.75 
Y1.75 
X0.75 
G0Z0.08 
M5 
G91G28X0Y0Z0 
M6T2 
G43H2 
M3S1500 
G90G0X0.25Y2.25 
Z0.08 
G1Z-0.125F3.9 
X1.75F5.9 
G2X2.25Y1.75J-0.5 
G1Y0.25 
X0.75 
G3X0.25Y0.75I-0.5 
G1Y2.25 
G0Z0.08 
M5 
G91G28X0Y0Z0 
M30 
  
Imperial (inches) sample CNC file with full formatting: 
Check that the units of measurement are set to "Inch".  The units of measurement are configured 
using the [Units] button on the "Options" toolbar. 
Copy and paste the CNC file listed below into a new (blank) "Editor" window. 
Save the CNC file as "Inch.fnc". 
   
N 001 G20 ; 
N 011 [BILLET X2.5 Y2.5 Z0.125 
N 021 [EDGEMOVE X0 Y0 
N 031 [TOOLDEF T1 D0.1875 
N 041 [TOOLDEF T2 D0.125 
N 051 G91 G28 X0 Y0 Z0 ; 
N 061 M6 T1 ; 
N 071 G43 H1 ; 
N 081 M3 S1500 ; 
N 091 G90 G0 X0.75 Y1.75 ; 
N 101 Z0.08 ; 
N 111 G1 Z-0.0625 F3.9 ; 
N 121 Y0.75 F5.9 ; 
N 131 X1.75 ; 
N 141 Y1.75 ; 
N 151 X0.75 ; 
N 161 G0 Z0.08 ; 
N 171 M5 ; 
N 181 G91 G28 X0 Y0 Z0 ; 
N 191 M6 T2 ; 
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N 201 G43 H2 ; 
N 211 M3 S1500 ; 
N 221 G90 G0 X0.25 Y2.25 ; 
N 231 Z0.08 ; 
N 241 G1 Z-0.125 F3.9 ; 
N 251 X1.75 F5.9 ; 
N 261 G2 X2.25 Y1.75 J-0.5 ; 
N 271 G1 Y0.25 ; 
N 281 X0.75 ; 
N 291 G3 X0.25 Y0.75 I-0.5 ; 
N 301 G1 Y2.25 ; 
N 311 G0 Z0.08 ; 
N 321 M5 ; 
N 331 G91 G28 X0 Y0 Z0 ; 
N 341 M30 ; 
 

  

  

Sample CNC file - Inch version  

Explanation of imperial (inches) sample CNC file: 

N 001 G20 ; (G20 defines the units of measurement being used as imperial - inch) 

N 011 [BILLET X2.5 Y2.5 Z0.125 (BILLET defines the size of the material being machined, called 
the billet, with X length 2.5", Y width 2.5", Z height 0.125") 

N 021 [EDGEMOVE X0 Y0 (EDGEMOVE defines work datum shift for the program, X0, Y0 
means no shift is applied) 

N 031 [TOOLDEF T1 D0.1875 (TOOLDEF defines tool number 1 with a cutting diameter of 
0.1875") 

N 041 [TOOLDEF T2 D0.125 (TOOLDEF defines tool number 2 with a cutting diameter of 0.125") 

N 051 G91 G28 X0 Y0 Z0 ; (G91 instructs the machine to follow incremental movements until told 
otherwise (incremental means all movements are described relative to the co-ordinate position 
achieved in the last program line).  G28X0Y0Z0 moves the cutter to the machine datum via the 
intermediate point indicated) 

N 061 M6 T1 ; (M6 instructs the machine to perform a tool change, if required.  Change to tool 
number 1) 

N 071 G43 H1 ; (G43 instructs the machine to use tool length compensation for tool number 1)
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N 081 M3 S1500 ; (M3 instructs the machine to switch the spindle on clockwise, with a speed of 
1500 rpm) 

N 091 G90 G0 X0.75 Y1.75 ; (G90 instructs the machine to follow absolute movements until told 
otherwise (absolute means all movements are described relative to the work datum point).  G0 
instructs the machine to fast traverse to position X0.75, Y1.75) 

N 101 Z0.08 ; (instructs the machine to move the cutter until it is 0.08" above the surface of the 
billet.  The last G code given was G0 (on the previous line) so the machine will fast traverse to this 
position) 

N 111 G1 Z-0.0625 F3.9 ; (G1 instructs the machine to cut a straight line from point to point.  Z-0.06 
instructs the machine to cut 0.06" into the material, since Z0 is the surface of the material.  F3.9 
instructs the machine to use a feedrate of 3.9" per minute) 

N 121 Y0.75 F5.9 ; (the last G code issued was G1, on line N111.  The cutter will move to position 
Y0.75, cutting a slot, with a feedrate of 5.9" per minute) 

N 131 X1.75 ; (the last G code issued was G1, on line N111.  The cutter will move to position 
X1.75, cutting a slot, continuing with a feedrate of 5.9" per minute) 

N 141 Y1.75 ; (the last G code issued was G1, on line N111.  The cutter will move to position 
Y1.75, cutting a slot, continuing with a feedrate of 5.9" per minute) 

N 151 X0.75 ; (the last G code issued was G1, on line N111.  The cutter will move to position 
X0.75, cutting a slot, continuing with a feedrate of 5.9" per minute.  This finishes the square shape 
etched into the centre of the billet) 

N 161 G0 Z0.08 ; (G0 instructs the machine to fast traverse to position Z0.08, moving the cutter 
0.08" above the surface of the billet) 

N 171 M5 ; (M5 instructs the machine to switch off the spindle) 

N 181 G91 G28 X0 Y0 Z0 ; (G91 instructs the machine to follow incremental movements until told 
otherwise (incremental means all movements are described relative to the co-ordinate position 
achieved in the last program line).  G28X0Y0Z0 moves the cutter to the machine datum via the 
intermediate point indicated) 

N 191 M6 T2 ; (M6 instructs the machine to perform a tool change.  Change to tool number 2) 

N 201 G43 H2 ; (G43 instructs the machine to use tool length compensation for tool number 2) 

N 211 M3 S1500 ; (M3 instructs the machine to switch the spindle on clockwise, with a speed of 
1500 rpm) 

N 221 G90 G0 X0.25 Y2.25 ; (G90 instructs the machine to follow absolute movements until told 
otherwise (absolute means all movements are described relative to the work datum point).  G0 
instructs the machine to fast traverse to position X0.25, Y2.25) 

N 231 Z0.08 ; (instructs the machine to move the cutter until it is 0.08" above the surface of the 
billet.  The last G code given was G0 (on the previous line) so the machine will fast traverse to this 
position) 

N 241 G1 Z-0.125 F3.9 ; (G1 instructs the machine to cut a straight line from point to point.  Z-0.125 
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instructs the machine to cut 0.125" into the material (cutting completely through the billet) since Z0 
is the surface of the material.  F3.9 instructs the machine to use a feedrate of 3.9" per minute) 

N 251 X1.75 F5.9 ; (the last G code issued was G1, on line N241.  The cutter will move to position 
X1.75, cutting a slot, with a feedrate of 5.9" per minute) 

N 261 G2 X2.25 Y1.75 J-0.5 ; (G2 instructs the machine to cut a clockwise arc.  The arc is cut from 
the position reached in the previous program line to the position X2.25, Y1.75.  The centre point of 
the arc is defined by J-0.5, where J indicates the X axis.  The centre point is -0.5" along the X axis 
from the start position of the arc.  The arc is cut with a feedrate of 5.9" per minute) 

N 271 G1 Y0.25 ; (G1 instructs the machine to cut a straight line from point to point.  The cutter will 
move to position Y0.25, cutting a slot, continuing with a feedrate of 5.9" per minute) 

N 281 X0.75 ; (the last G code issued was G1, on line N271.  The cutter will move to position 
X0.75, cutting a slot, continuing with a feedrate of 5.9" per minute) 

N 291 G3 X0.25 Y0.75 I-0.5 ; (G3 instructs the machine to cut an anticlockwise arc.  The arc is cut 
from the position reached in the previous program line to the position X0.25, Y0.75.  The centre 
point of the arc is defined by I-0.5, where I indicates the Y axis.  The centre point is -0.5" along the 
Y axis from the start position of the arc.  The arc is cut with a feedrate of 5.9" per minute) 

N 301 G1 Y2.25 ; (G1 instructs the machine to cut a straight line from point to point.  The cutter will 
move to position Y2.25, cutting a slot, continuing with a feedrate of 5.9" per minute) 

N 311 G0 Z0.08 ; (G0 instructs the machine to fast traverse to position Z0.08, moving the cutter 
0.08" above the surface of the billet) 

N 321 M5 ; (M5 instructs the machine to switch off the spindle) 

N 331 G91 G28 X0 Y0 Z0 ; (G91 instructs the machine to follow incremental movements until told 
otherwise (incremental means all movements are described relative to the co-ordinate position 
achieved in the last program line).  G28X0Y0Z0 moves the cutter to the machine datum via the 
intermediate point indicated) 

N 341 M30 ; (M30 defines the end of the program and rewinds back to the start of the CNC file) 

  

 

  

Setting the Units of Measurement  

The units of measurement used by the VR CNC Milling software must be set to match the units of 
measurement used by your CNC file and any tool profiles used.
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For example, if you set the VR CNC Milling software to run in Metric Mode, you must use a metric 
compatible CNC file and metric tooling. 

 

Click the [Units] button (shown above) from the "Options" toolbar, to change the units of 
measurement mode between: 

"Metric" Mode:  Metric - millimetre units. 

"Inch" Mode:  Imperial - inch units. 

 

The current setting of the option is displayed in the main program status bar, positioned in the 
bottom left corner of the main program window.  The first information box on the upper line of this 
status bar (highlighted red in the screenshot above) indicates the units of measurement currently in 
use. 

The units of measurement can also be configured using the "Setup | Units" menu option. 

 

  

  

Creating a New CNC file  

Part 1: Creating a New CNC file 

Click "File | New" to create a new CNC file, as shown below.
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The blank "Editor" window will be displayed, as shown below. 

The "Editor" window behaves in a similar way to a simple word processor, such as Windows 
Notepad. 

 

  

 

  

Wizards 

Wizards are an easy way to write CNC programs by selecting operations from a menu instead of 
typing in codes directly into the editor. After selecting the option, lines of CNC code are 
automatically entered into the program for you. 

To use a wizard :-  

1. Position the cursor at the position where you require the operation to be inserted.  
2. Right mouse click anywhere in the editor window to display a pop-up menu.  
3. Select the Wizards option and then select the operation from the sub-menu.  
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4. Most wizards require settings to by entered into a dialog box… when done click the [OK] 
button.  

5. The appropriate lines of CNC code will entered into your CNC program. 

Example of the Linear Interpolation (G01) wizard 

 

Values are entered into the white input boxes for each parameter. 
 
Note :The relevant areas in the diagram will become highlighted in yellow as you click in the 
associated input box. 
 
When the [Change] button is pressed, a different wizard type can be selected from the list. 

 

 Help - CNC Programming  

 

  

Editing a CNC file 

Part 1: Positioning the "Editor" window cursor 
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The "Editor" window cursor is a flashing vertical black line, shown circled red in the above 
screenshot.  This cursor shows where characters can currently be inserted, removed or highlighted.  
To remove characters directly behind the "Editor" window cursor, press the [Delete] key.  To create 
a new CNC file line, press the [Enter/Return] key. 

The mouse positioning cursor is a vertical black line with bars at its top and bottom, shown circled 
yellow in the above screenshot.  This cursor is used to move the "Editor" window cursor to new 
positions in the CNC file. 

To reposition the cursor in the "Editor" window: 

Position the mouse positioning cursor in the required area, then click the left mouse button to move. 

Use the four computer [Cursor] arrow keys to move the "Editor" window cursor to the required 
position. 

Use the [Page Up] key to move to the top of the CNC file. 

Use the [Page Down] key to move to the bottom of the CNC file. 

Use the [Home] key to move to the beginning of the current CNC file line. 

Use the [End] key to move to the end of the current CNC file line. 

  

 

  

  

Formatting a CNC file  

Part 1: Adding Program Line Numbering 
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To add program line numbers to your finished CNC file, click "Modify|Line Numbering..." to 
display the "Line Numbering" window. 

 

Enter the number you want to use as first line of the program in the "Start Number" dialogue box.  In 
the example above, 1 has been specified. 

The "Numbering Increment" dialogue box is used to set the numerical gap between each program 
line number.  In the example above, 10 has been specified, so the program line numbers will follow 
the sequence 1, 11, 21, 31, 41, 51 etc. 

The "Minimum number length" dialogue box is used to set the amount of characters used to display 
each program line number.  In the example above, 3 has been specified, so the program line numbers 
will follow the sequence 001, 011, 021, 041, 051 etc. 

The "Numbering Token" dialogue box is used to add an address character to start of each program 
line number.  The standard numbering token used is N.  In the example above, the program line 
numbers will follow the sequence N 001, N 011, N 021, N 041, N 051 etc. 

Click the [OK] button to apply program line numbering settings to the CNC file. 

An example of a modified CNC file is shown below. 

Before modifications: 

 

After modifications (add program line numbering):
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Saving a CNC file  

 

To save your CNC file, click "File|Save As".
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Select the directory used for storing your CNC files, using the "Save in:" panel. 

Enter the filename in the "File name:" dialogue box, using the file extension ".fnc", as shown above, 
then click the [Save] button. 

 

  

  

Loading a CNC file  

Part 1: Loading a CNC file 

 

To load a previously saved CNC file, click "File | Open".
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Select the directory used for storing the CNC file, using the "Look in:" panel. 

Click on the name of the file required - its name will appear in the "File name:" dialogue box. 

If the "Simulation | Options | Auto Save Bitmap" option was ticked when the file was saved then a 
thumbnail image of the CNC file is also displayed in the right-hand panel, as shown above. 

Click the [Open] button to load the CNC file into the "Editor" window. 

  

 

  

Macro Programming 

Macro programming allows you to: 

1. Set up variables which can be altered during the execution of your CNC program to effect any 
of the usual G or M code values: 
#500=20 
- this CNC code will set variable number 500 to the value 20 
G01 X#500 F300 
- this code will be interpreted as G01 X20 F300, in other words we have substituted an X 
target position with whatever value is stored in variable number 500. 

2. Test variables for certain conditions, and if they are true then alter the execution order of your 
program: 
IF [#505 GT 0] THEN GOTO 10 
- here the program checks the value of variable #505 and if it is greater (GT) then 0 then 
program execution jumps to block number 10 (ie N10) 

3. Apply mathematic formulas to variables: 
#506=SIN[30]*#502 
- here the variable number 506 is set to the sine of 30 degrees then multiplied by value stored 
in variable number 502. 
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As you can see, these features can be very powerful in creating short CNC programs that can be 
quickly reconfigured to do a similar job just by altering a few variables. 

Macro commands available are: 

GOTO 
IF [condition] THEN do something 

Conditionals :- 

EQ - IF [#5 EQ #6] THEN ... {equals} 
NE - IF [#5 NE #6] THEN ... {not equals} 
GT - IF [#5 GT #6] THEN ... {greater than} 
GE - IF [#5 GE #6] THEN ... {greater than or equals} 
LT - IF [#5 LT #6] THEN ... {#5 less than #6} 
LE - IF [#5 LE #6] THEN ... {less than or equals} 

Maths :- 

#var=#var 
+ - * / {#500=20*45} 
SIN 
COS 
TAN 
ATAN 
SQRT 
ABS 
ROUND eg #500=SIN[45]*10 or #500=ATAN[10]/[40] 

A window displaying the current state of variables can be view by selecting the "Setup | Macro 
Variables" pull down menu 

Examples: 

Bolt hole drilling program 

 

 Macro Variables  
 Help - CNC Programming  
 Using Wizards to write CNC programs  
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Running a 2D Simulation of a CNC file  

Part 1: Displaying the "2D Simulation" window 

 

To display the "2D Simulation" window, click the [2D/3D Simulation] button, shown above, from 
the "Outputs" toolbar. 

 

Click the "2D simulation" button from the toolbar. 
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Running a 3D Simulation of a CNC file  

Part 1: Displaying the "3D Simulation" window 

 

To display the "3D Simulation" window, click the [2D/3D Simulation] button, shown above, from 
the "Outputs" toolbar. 

 

Check that the "3D simulation" button is pressed from the toolbar. 
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2D - 3D - VR Simulation - Page 1 of 5 

To enter the Virtual Reality world click on the VR machine button  

 

When running in VR Machine Mode, the "Denford Virtual Reality" window is used to display a 
three dimensional representation of the CNC machine. This VR machine is driven and responds in 
exactly the same way as its real-life counterpart, making the VR Machine Mode ideal for offline 
CNC training.  

Navigation bar 

 

Use these buttons to move around the VR world. Click here for more information. 

Interacting with the world 

Some of the functionality of the models can be achieved by clicking on the relevant objects.
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 Left click on the handle to open and close the guard.
 Left click on the red button on the front of the machine to add/remove the cabinet (for a better 

view inside the machine). 
 Billet Position – Hold down the left [SHIFT] + left mouse button on the virtual billet to drag it 

to a new position on the machine table. The X and Y co-ordinates of the billet are displayed at 
the bottom of the VR – 3D – 2D window. These co-ordinates refer to the distance from the 
front left hand corner of the machine table to the front left hand corner of the billet. The size 
and position can be changed in the "Simulation | Default Billet Size" menu. 

  

Options Bar 

 

The options bar menu allows you to customise the settings within the virtual world. 

 

  

  

Starting a real CNC Machine  

Part 1: Power-up Procedure 

1) Ensure the cable is fitted securely between the computer and the CNC machine. 

2) Switch on the CNC machine. 

3) Power up the computer and start the VR CNC Milling software. 

3) Before starting the real CNC Machine: 

Check that the units of measurement set for the VR CNC Milling software matches the units used in 
both the CNC file and any tooling profiles.  The units of measurement setting for the VR CNC 
Milling software is configured using the [Units] button on the "Options" toolbar. 

Check that the tool numbers and tool profiles used in the "Tool and Offsets Editor" window match 
those used by your CNC file. 

Check that any tools present in a real Automatic Tool Changer, when fitted, match the exact position 
numbers of the tools configured in the "Tool and Offsets Editor" window.
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5) To start the real CNC Machine, single click the [Machine]  button.  

The "Control panel" window will open.  This window is used for controlling the movements of the 
real CNC machine using exactly the same principles as for the VR CNC machine described in the 
previous tutorial section. 

  

 

  

  

Homing a real CNC Machine  

Part 1: Home Mode 

 

When a real CNC machine is first started, the "Machine Mode" window will be displayed with only 
the "Home" tab active, as shown above. 

The "Home" tab is used for configuring the machine before it can be fully used.  This defines the 
Machine Datum, used as a zero reference for describing other co-ordinate positions and defines the 
limits of co-ordinate movement for the machine. 

Note:  The "Jog" and "Auto" tabs will not be displayed until the machine has been configured by 
homing all of the three axes. 
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Homing the CNC Machine Axes 

To configure the machine X axis only, click the [X Axis ONLY] button.  The X machine slide will 
move until it has found its limits of co-ordinate movement. 

To configure the machine Y axis only, click the [Y Axis ONLY] button.  The Y machine slide will 
move until it has found its limits of co-ordinate movement. 

To configure the machine Z axis only, click the [Z Axis ONLY] button.  The Z machine slide will 
move until it has found its limits of co-ordinate movement. 

To configure all three axes together, click the  button.  All machine slides will move until 

the limits of co-ordinate movement have been found. 

Note:  The numerical figures depicted on any screenshots will differ according to the CNC machine 
type, the units of measurement setting for the VR CNC Milling software and any offsets being used 
on your computer system. 

 

 Troubleshooting homing the machine  
 CNC  Theory - Homing the machine  

 

  

  

Moving the Axes on a real CNC Machine  

Part 1: Jog Mode 
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The "Jog" tab is used for manually moving the machine within its co-ordinate working envelope. 

Jog Control Modes 

The "Jog" panel displays the [Jog] button, a dial and the jog control value. 

The machine table and head can be jogged, or moved, using two different methods, outlined below.  
To change between these two methods, click the [Jog] button. 

To change the jog control value, click and hold down the left mouse button on the dial, then drag the 
cursor up or down to the new position. 

When the [Units] of Measurement are set to "Inch" the rate of movement is measured using inches 
per minute.  When the [Units] of Measurement are set to "Metric" the rate of movement is measured 
using millimetres per minute. 

Jog Continuous:  In jog continuous mode, the selected machine axis will move at the indicated 
speed when one of the machine axis movement keys are pressed and held down.  The selected 
machine axis will continue to move until the key is released.  The dial can be moved to set jog 
speeds between 0 and 1000 units.  When Jog Continuous is active, the [Jog] button graphic will be 
displayed as shown below. 

 

Jog Step:  In jog step mode, the selected machine axis will move one indicated increment, each time 
the selected axis movement key is pressed.  The dial can be moved to set the jog increment.  When 
Jog Step is active, the [Jog] button graphic will be displayed as shown below. 
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Note:  The numerical figures depicted on any screenshots will differ according to the CNC machine 
type, the units of measurement setting for the VR CNC Milling software and any offsets being used 
on your computer system.  

  

  

Configuring Offsets with a real CNC Machine  

Part 1: What are Offsets? 

When we write a CNC program, all co-ordinates used for describing the shape of the part are stated 
relative to a zero reference, called the part datum. 

The part datum should be positioned in a convenient location with respect to the actual size of the 
billet you intend to use, as shown below.  This position will need to be identified later on the real 
billet. 

In the sample CNC files used with this tutorial, the part datum is positioned in the top left-hand 
corner of the imaginary billet. 

The CNC machine also has a zero reference, called the machine datum.  If no offsets are loaded, our 
CNC file will use this position as the start location for any machining co-ordinates. 

Offsets are used to establish the location of the workpiece datum on the real billet.  The workpiece 
datum is the position where we want any physical machining co-ordinates to be taken from.  Using 
the Offsets facility, we can temporarily shift the entire co-ordinate based grid system of the CNC 
machine.  We must move the three dimensional grid, so the position of the workpiece datum 
registers as zero, rather than the position of the machine datum. 

Note that the workpiece datum must be positioned on the real billet in the same place as the part 
datum datum was positioned with respect to the imaginary billet.  If these datums do not align, the 
part will be machined in the wrong place on the real billet. 

Offsets are very important because without them, the CNC machine will not know where to begin 
cutting on the billet.  Offsets must always be configured before manufacturing our part.  However, 
once you configure and save an offset file, the same file may be used over and over again, as long as 
the following holds true: 

- The same cutting tools are used. 

- The billet size does not change. 

Page 30 of 56

15/12/2010



- The fixture that holds the billet does not move position on the machine table. 

Click here for more detailed information about Offsets 

The Process of Configuring Offsets 

In order to establish the workpiece datum, so it is in the same position for all the tool profiles we 
want to use, two types of offset file must be configured: 

1) The Workpiece Offset File - This file allows global values to be set for the X, Y and Z co-
ordinates, i.e., workpiece offset values are used by every tool, irrespective of tool size.  The X and Y 
offsets need only be set once, since their values are common to all tool profiles. 

2) The Z Tool Length Offset Files - Since all tool profiles differ in length, each tool profile has its 
own individual Z tool length offset file.  These values will be different for each tool.  They 
compensate for the differences in length, so various tools can be used together on with single CNC 
file. 

The X position of the workpiece datum is defined by the value entered into the X dialogue box of the 
workpiece offsets file. 

The Y position of the workpiece datum is defined by the value entered into the Y dialogue box of the 
workpiece offsets file. 

The Z position of the workpiece datum is defined by the combination of the value entered into the Z 
dialogue box of the workpiece offsets file and the individual Z tool length offset value for the tool 
being used at the time. 

Configuring the Tool Offsets for the Sample CNC file on a real CNC Machine 

If you are running through the tutorials using the sample CNC files, the diagram below shows the 
locations of the billet, temporary MDF machine bed, machine datum and programmed workpiece 
datum. 

Note - In the diagram below, all axes have been homed.
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Recap - When we configure the offsets, we are temporarily shifting the entire co-ordinate based grid 
system of the CNC machine, so its zero co-ordinate aligns with our workpiece datum. 

Important ! 

You must use a temporary machine bed because the sample CNC file include sections where the tool 
cuts completely through the billet.  Naturally, if we attempted to use the sample CNC file without 
this hardware, we would cause considerable damage to the machine table!  We recommend that you 
use MDF (medium density fibreboard) or a similar smooth flat material for the temporary machine 
bed.  The plastic billet should be held in position using double sided tape, as shown below. 
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Next > 

Introduction 

In response to requests to produce circuit boards with machine tools as opposed to acid etch, 
Denford have developed a file import for both Gerber files and NC drill files. 

The principles of etching boards required the minimum amount of copper to be removed to save the 
etch solution becoming saturated and ineffective. As a result on most PCB’s a ground plane would 
be created to fill the areas of the board that are not used. 

When machining boards a boundary around the tracks and pads is cut to a depth greater than the 
layer on the copper clad board. Ideally the minimum amount of cutting will be done and as much 
clearance around the tracks as possible should be given. If there is an option then the “Area Fill or 
“Ground Plane” will be removed. 

Machining PCB’s has a disadvantage over etching in that the minimum track pad isolation gap has to 
be increased to allow the cutter to pass between the two. 

As a result the tooling to be used for machining should be taken into account before designing the 
circuit. 

In most cases when machining a PCB the profiling tool will cut a path about 0.4mm wide so the 
minimum isolation gap that should be designed is set to this value or preferably higher (0.5mm). 

When saving the file as a Gerber format file the board boundary should be defined either on the 
screen, board boundary or with a copper track outline. 

Next >  

 

< Prev Next >  

Exporting a file from PCB Wizard 

In this section we will cover the settings required to export a Gerber file from PCB Wizard to make 
it suitable for manufacture on a CNC machine. 
We will use the first sample circuit contained in the software as an example.  
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< Prev Next >  

Exporting a file from PCB Wizard 

In this section we will cover the settings required to export a Gerber file from PCB Wizard to make it suitable 
for manufacture on a CNC machine. 
We will use the first sample circuit contained in the software as an example.  

Open PCB Wizard. 
The getting started Wizard will appear:  
Select Open Sample Circuits: 

 

Select the 555 Astable.pcb file: 

 

Click “Open” 

The standard PCB Wizard screen below is displayed.
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The PCB tracking shown has a large ground plain or flood fill area. This is inserted automatically by PCB 
Wizard and has to be removed before exporting the gerber file to be manufactured:  
TIP - choose to view "Artwork" by selecting the button down the left hand side of the application  

In the example files in PCB wizard the documents are locked and cannot be edited. 
To be able to remove the ground plain it is necessary to unprotect the document. To do this, select the “File” 
menu. Then select “Unprotect Document” : 

 

  

Now select the ground plain on the tracked PCB. Right Click the Mouse to get the function menu.  
If all the options are greyed out then the document is protected. 
Select “Delete”. 
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All that is now left is the track layout and identifying text label. 

 
Machining around the Text will be a problem and will probably produce errors so you may wish to remove the 
text as well. 
If you want to remove the Text simply select it then Right click the mouse then Select “Delete”. 

The circuit is now in a format where it can be exported as a Gerber file for manufacture. 
Gerber format (RS-274X) is an industrial standard transfer file for defining circuit board tracks and pads. 
Select the “Tools” menu then "CAD/CAM" and finally "Export Gerber" output: 

 

This will then open a sub menu where it is possible to define which layers and information you wish to output.
In this case we only have a Bottom Copper layer. 
The Export Gerber menu is shown: 
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Select the ”Save As” option after File Name 
This allows you to define where the gerber files will be saved. 
Create a folder and note where it is located. Name the file and click “Save”. 
The following selections (as shown in above image) should be made. 

Check the following: 
Circuit Board 
Solder Side 
Drill Holes 
Place each layer in a separate output file 
Drill Holes 
Include Aperture table 

Uncheck the following: 
Plot Pads Only 
Fill Drill Holes 

Select “OK”. 
The files are automatically created and placed into the folder specified. 

Explore to the folder and you can view the files as shown: 

 

Right click on the Drill file and select the "Open" or “Open With” option. Select Notepad from a list and the drill 
file will be opened. This file shows a list of X, Y co-ordinates that correspond to the centre of each of the drill 
holes. It also shows that there are two tools used. T01 drills most the holes while T02 drills the last two:
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Next open the Astable.INF file. This is a report file and again can be opened in Wordpad. If you cannot see 
this file in the folder it may be the folder display properties on the computer you are using need to be 
changed. From other PCB packages this file may have a different file extension.  
This file defines the pad sizes and drill sizes as well as information about the unit, date created etc: 

 

The other two files in the folder are the gerber output files for the Circuit Board outline and the solder side 
tracking. 
While PCB Wizard automatically names each layer GB0 to GB3 depending on the number of layers exported.
Most packages add the layer to the reference file name. 
The standard file format is .GBR for Example the output file would be: 555 Astable-bottom copper.gbr 

Congratulations ! The file export has now been successfully completed. 

  

< Prev Next > 
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< Prev 

Importing a Gerber File into VR Milling v5  

The Gerber import was introduced into VR Milling 5 with the release of Ver 5.7 (May 2005) 
To check your current version go to the Help Menu then select “About”. 
If you have a previous version of VR Milling 5 you can download an upgrade CD free of charge from the 
Denford Website. 

Run the VR Milling 5 Software. 
Select “File” “Open”. 
Select the file types dropdown and select “Gerber Files (*.gb*)” 

 
Select the “555 Astable.gb0” file 
Select “Open” 
The Gerber Import Wizard opens as shown: 

Define Board 

 

The origin is drawn in the bottom left corner of the PCB but the top right extreme is defined by the last used 
PCB size. 
Press "Auto Size" to set the board size to match the extents of the PCB tracks 

If you know the size the board was designed at type the values into the width and height boxes. 
In this case the board is defined as 61mm x 61mm in size. 
As you change the values the board shown will also change in size. 
The first layer imported is useful as it defines the board size but we do not want to machine this. 
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Close the Wizard (Cross at top right hand corner) and select “File” “Open” once again. 
Select the “555Astable.gb1”. This is the bottom copper file. Select Open. 
The bottom copper artwork is opened in the Wizard as shown. 

 

The Width and Height values should have been remembered from last time, setting the board size to: 61mm x 
61mm. 
Click “Next”. 
TIP: The image can be manipulated with the mouse. In the display window “Left click” the mouse and drag will rotate the image. Right 
Click and drag will zoom into the image. Left and Right together will PAN the image. 

Select Side 

With most PCB design packages the view of the board is from the component side looking downward. By 
default the gerber file is also done this way. The bottom side or Solder side will be a mirror image of this when 
the board is turned over. 
Select “Solder Side” and the image will mirror from left to right as shown:
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The view is now shown as it will look when machined. 
Note: For double-sided boards the component side does not need to be mirrored. 
Select “Next”. 

Generate Toolpath 

To be able to generate the toolpath you need to define the depth you want to cut to (making sure you cut right 
through the copper) and the diameter of the cutter you are going to use (to ensure it can get between the 
pads and tracks). 
A typical depth to use would be 0.3mm as this will machine through the copper and into the board behind. It is 
also deep enough to take out some error if the board was not flat while machining. 

The standard engraving cutter Denford recommend is a 0.25mm tip with a 30-degree angle. Cutting at 0.3mm 
deep will leave a groove about 0.4mm wide. 

Set the Cutting depth the 0.3mm 
Set the Cutter Diameter to 0.4mm 
Select “Calculate” 

 

The cutter path around the tracks is calculated and displayed offset by half the diameter so in this case 
0.2mm outside the tracks. 
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If the red warning banner appears then there is a problem somewhere in the design and the cutter cannot 
pass between all the tracks. 

Using the Zoom and Pan tool (via mouse buttons) you can inspect the tool cutter path and search for the 
error. If an error is found due to the tracks being too close together then you will need to modify your PCB 
design or find a narrower cutter. 

 

In this design there is no problem with the tracking but it is the Text that is the problem. As the text is treated 
as a copper track if the tool cannot pass between the letters it will show as a possible error. 
As you can see in the picture the tool path is unable to profile round the text and as a result the file has 
warned there could be an error. 

 

Removing the text from the PCB before exporting would prevent the error occurring.  
In the example shown here the tool width has been set to 0.7mm and the new toolpath calculated. 

 
As the software will not allow the tool to pass through a gap that is too small as it would machine away copper 
that is required to make a connection the resulting tool path would leave all the pads on the IC Base 
connected together. 

Note also that a pad with a hole in the center will produce this same error, if the tool diameter is too big to cut 
inside the hole, eg: 
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Once you are happy there is no problem machining the Tracks and Pads click “Next”. 
Tip: Care must be taken to ensure large enough isolation gaps were designed into the PCB before exporting as a gerber file. 

Drilling Operations 

There are two options available to you when drilling a circuit board. Provided the Check Box: “Fill Drill Holes” 
was unchecked when the files were exported the pad information includes the internal hole sizes and the 
external pad diameter. As a result the Wizard can automatically calculate the number of different sized holes 
in the board and allocate a drill of that correct diameter to each hole. 

Here the Auto Drill setting is selected and the Wizard has selected two drill sizes to be used. 
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The drill depth can be set to any value but in this case it is set to 2mm so as to pass right through the board. 
A normal PCB is only 1.6mm thick.  
It is possible to stop holes being drilled by un-checking the box next to the drill diameter. 

Here the 0.508mm drill is unchecked and you can see the drill indicators are removed over the IC base: 

 

If the box is left unchecked then the CNC file will not include the drilling detail for that tool. 

The second method of drilling a PCB is to import the drill file. 
To do this click on the “Read Drill File” button. 
Locate the file 555 Astable.drl and “Open”. 

 

This time the drill centres are shown with a default drill diameter. Again the two different sizes of drill are 
shown but the correct diameters are not given. 
In this instance you have to read the “ini or report” file to find the diameters of the drills required and ensure 
they are fitted when the tool number is requested. 
All drilling operations that are grouped by tool size, can be overridden and all drilled with the same tool. To do 
this, check the box "Pilot Drill Only" and select the drilling tool number. Doing this will cause all holes (that are 
turned on) to be drilled with the one tool, in effect pilot dilling them for opening out later.  
Select “Next”. 

Speeds and Feeds 

A default spindle speed and tool feedrate is allocated to each tool used in the program. 
These feeds are the suggested values Denford recommend but each one can be customised as required. 
Once the values are approved, select “Next”. 

CNC Output 

It is possible to output the CNC code to cut the following combinations:
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The tracks only 
Drilling the holes only 
Spot drilling only (to the same depth as the track cut depth, using the track cutter tool) 
Or, any combination of the above 

It may be that you want to just output the track outline and then drill the board latter on a pillar drill, if so 
uncheck the “Output drilling operation” as shown. 
If you want the drill output recheck the box. 

Select “Create CNC”. 
The Wizard software will close and re-launch VR Milling 5. The newly created toolpath is loaded into the 
current editor. 

The example shown shows the file loaded into the full editor with colour formatting on: 

 

The section at the start of the program (program header) has comments within brackets.  

These comments tell you about the program, how it was created. They also includes information on the tools 
to be used, track side to be machined and a warning if there were isolation problems while processing.
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The fast editor should be used for manufacture and is shown below: 

 

The program is now ready to be manufactured in the normal way. 

< Prev  
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Drawing Import CAM  

Next >  

Introduction  

VR Milling version 5.10 has a new additional Import Feature. 

This allows designs to me made in the users CAD package of choice then saved as a DXF or DWG. 

The DXF or DWG can then be imported directly into VR Milling through a Wizard based CAM 
package without having to use any other intermediate package or post processor. 

The CAM wizard uses central machine and tooling and material libraries within VR milling to 
ensure only the tools you have available can be used and that suitable feeds and speeds are 
automatically generated. 

Import DXF or DWG 

 

From the “FILE” Menu select “OPEN”. 

From the file type drop down Select “DXF and DWG Files”
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Browse for the file you wish to process the select “OPEN”

  

Material Selection 

 

Once you open the file you have the opportunity to select the material type from the drop down 
menu.  

This will select the feed speed and maximum depth of cut the program will create based on the 
material selected. 

You can add, edit and save the material types within VR Milling 

Layers and Scaling 

 

Some designs will be imported on multiple layers. It is possible to deselect layers so as to discard 
unwanted information. 

The Wizard will import the design at the exact size it was created, any scaling must be done in the 
design package before exporting.  

Files can however be exported in Inches or Metric so an option is available to select the corect units.
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Next >  

Drawing Import CAM  

< Prev Next >  

Billet Definition 

 

The size of the Billet is now defined. The size is automatically set to create an equal boarder around 
the part based on where the user origin is located. 

The Billet size can be changed by typing values in each box or by clicking or dragging the sliders  

The block size is defined from the User Origin as exported in the initial design. 
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By deselecting the “Use Drawing Origin” box the billet size can be dragged by either dragging the 
origin or the handle in the top right corner. 

Using “Drawing Extents” sets the billet size to the extents of the drawing with no boarder around it. 

Ensure the block depth is entered as this is used latter for error checking. 

  

Machining Plans 

 

Multiple machining plans can be created using any of the vectors in the design. 
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Each plan can be created, placed in order, disabled or deleted.

Each plan is listed in the order it is created. 

The function of each plan is explained next. 

< Prev Next >  

Drawing Import CAM  

< Prev Next >  

Follow Vector 

 

This tool is used normally for engraving. The vectors to be followed are selected by clicking on 
them.  

The tool to be used is selected from the drop down and the required depth set. 

Click “Apply” and the toolpath is calculated.  
If the tool or vector selection is changed you must re apply to recalculate. 

Select “OK” and the tool path is generated creating as many passes as required to get to the 
requested depth. 

Inside Offset Cut 
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This tool will create a tool path inside a Vector offset by the radius of the tool diameter. 

In this case the tool path is created offset 3mm (6mm-diameter cutter) inside the selected vector 
ellipse 

The above cutter path would remove some of Dennys' foot. 

  

 

Multiple vectors can be selected and then the path will take into account the areas it cannot get to. 

The software automatically decides what areas are islands and what can and cannot be machined.
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In the Advanced control box it is possible to re-order Vectors.

< Prev Next >  

Drawing Import CAM  

< Prev Next >  

Outside Offset Cut 

 

This tool is much the same as inside offset. 

In this case Text is selected with a 2mm tool and 2mm depth of cut. 

On selecting “Apply” the cutter path is generated for all the letters. 

The advanced function has recognised the inside of the D as an island and has automatically put it on 
the second level which, as a result, creates the offset toolpath within the letter. 

  

Area Clearance Cut 
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This plan removes the area of material enclosed by a vector but leaves any other selected vector 
islands intact. 

If the tool cannot fit between two vectors it will remove only what is possible. 

The tool path created follows the outline of the vector shape  

  

 

The tool step-over can be set within the Plan. With softer materials a larger step-over can be used for 
hard materials it can be reduced. 

By default the step-over value is set to 50% of the tool diameter. The above images shows an 
increase in tool stepover.  

  

< Prev Next >  

Drawing Import CAM  

< Prev Next >  

Raster Clearance Cut 
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This plan does much the same as the Area Clearance plan but instead of following the contour of the 
shape the cutter path rasters in linear moves. The tool will lift out and rapid over any islands. 

Again the tool step-over can be modified depending on the material being used. 

The Raster toolpath is cut first then an inside offset toolpath is generated to clean up all the edges of 
the shape. 

  

 

It is also possible to set a different Raster angle as shown above.
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Again the if multiple vectors are selected they are automatically ordered.

The advanced function allows the order to be rearranged as desired. 

  

Drill Cut 

 

This plan will find the centre of any circle included in the design.  

The circles that you wish to drill are selected and highlight in green then the tool and depth is 
selected. 

When the tool path is calculated the holes will be peck drilled with the material depth of cut setting 
the peck depth. 

If different holes are to be drilled different depths then create multiple plans. This would allow holes 
to be counter bored by selecting the same hole in two plans. 

  

< Prev Next >  

Drawing Import CAM  

< Prev 

Check Output and Post Process 
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It is possible to view the cutter paths associated with each Plan just by selecting the plan in the list. 

Un-checking the plans here will prevent them from being simulated or post processed. 

The simulation allows you to check if the cutter moves outside the billet or cuts through the base.  

In this case only the raster Clearance cut has been selected. 

 

Select “Check Output” and the tool-paths are simulated in order. 

This allows you to check if the order of machining is correct before creating the code. 
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The tool diameter is shown. 

Rapid moves are shown in Red while the cut path is shown in Blue. If the depth requires multiple 
passes these will also be shown.  

  

 

In this example the outline of Denny has been cut using the “Follow Vector” plan. 

The Text was cut with the “Outside Offset Cut” 

As the centreline of the cutter is close to the edge of the block the actual cutter diameter will break 
through the side of the block. 

While this may be OK the cutter could hit a clamp so a Red warning message is displayed. 

This will not prevent the file being Post Processed but is displayed as a warning. 
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Select “Post Process” 

The G&M code will be created and will open in the machine editor. 

The screen shown is has the program opened in the full editor with colour formatting on. 

The file can now be manufactured in the normal way. 

< Prev 
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CNC Theory: Homing the CNC Machine 

Immediately after being switched on, all three axes of the CNC machine must be homed. 

When you home the CNC machine, all three axes will move to the furthest positions available on 
their slides, as shown in the diagram below. 

 

Homing the CNC machine defines: 

The co-ordinate based system used for plotting any programmed movements - this gives us a 
working envelope for the cnc machine (explained further in a later section). 

The machine datum - the zero reference point for the CNC machine (explained further in a later 
section). 

In addition to homing the CNC machine after it has been switched on, it is also recommended that 
the CNC machine is homed after loading or configuring offsets. 
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CNC Theory: The Co-ordinate Based Grid 
System 

Precise points are plotted on the CNC machine using the positions of the X, Y and Z axes. 

These X, Y and Z values relate to a three dimensional grid, as shown in the example below. 

 

The zero point of this grid is called the datum.  The graduated gird-lines represent the directions of 
the three CNC machine axes. 

 

  

CNC Theory: The Machine Datum 

The machine datum, or home position, is the zero reference point of the CNC machine.  It's the point 
from which all co-ordinates we load or program are calculated.  If there are no offsets loaded and we 
begin to run a CNC program, the machine datum is the location where any machining will begin.
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The position of the machine datum is set by your CNC machine manufacturer and can never be 
moved, since it defines the physical movement capability of the machine. 

If we place a tool in the machine head, then home all three axes, we can describe the machine datum 
as being the centre of the cutting tool tip.  The position of the machine datum, when using machine 
co-ordinates, will be X=0, Y=0 and Z=0, as shown in the diagram below. 

 

 

  

CNC Theory: The CNC Machine Working 
Envelope 

The diagram below shows the home position of the CNC machine. 

The red block represents the maximum working envelope of the machine, effectively the full length 
of movement in each of the three axes.  This is the largest possible size of workpiece that the CNC 
machine could manage to cut, with the tool currently held in the machine head. 

However, workpieces larger than this size can be accommodated, so long as they don't foul the 
insides of the machine cabinet when the machine table moves.
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CNC Theory: Co-ordinate System Display 
Modes 

The CNC machine can plot co-ordinate movements using two different modes: 

Machine Co-ordinates:   

Any co-ordinate values plotted relate to the fixed machine datum.  The co-ordinate display always 
shows the true position of the machine.  The machine datum position is set by your CNC machine 
manufacturer and can never be moved, since it defines the physical movement capability of the 
machine. 

When running in Machine Co-ordinates Mode, the Machine Datum is displayed with the position 
X=0, Y=0, Z=0. 
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Workpiece Co-ordinates:  

Any co-ordinate values plotted relate to the programmed workpiece datum.  The co-ordinate display 
shows the position of the machine when any offsets are being used.  The workpiece datum is set by 
the operator as the location where we want any machining to begin.  Offsets temporarily shift the 
entire co-ordinate based grid system of the machine, as shown below. 

When running in Workpiece Co-ordinates Mode, the Workpiece Datum is displayed with the 
position X=0, Y=0, Z=0. 
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CNC Theory: What are Offsets? 

When we write a CNC program, all co-ordinates used for describing the shape of the part are stated 
relative to a zero reference, called the part datum. 

The part datum should be positioned in a convenient location with respect to the actual size of the 
billet you intend to use, as shown below.  This position will need to be identified later on the real 
billet. 

We recommend that the Z co-ordinate of the part datum is set on the upper surface of the billet you 
intend to use.  In doing so, any negative Z values programmed will indicate that the tool is cutting 
into the billet, any positive Z values programmed will indicate that the tool is clear from the billet.
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However, the part datum can be positioned anywhere.  It could be positioned in one of the corners of 
a part design drawing.  On a largely circular design it could be positioned in the centre of one of its 
circles.  In most CAD/CAM software packages it may be set automatically when the CNC program 
is generated.  For example, Denford MillCAM Designer positions the part datum in the front upper 
left-hand corner of the billet 

The CNC machine also has a zero reference, called the machine datum.  If no offsets are loaded, our 
CNC program will use this position as the start location for any machining co-ordinates. 

Offsets are used to establish the location of the workpiece datum on the real billet.  The workpiece 
datum is the position where we want any physical machining co-ordinates to be taken from.  Using 
the Offsets facility, we can temporarily shift the entire co-ordinate based grid system of the CNC 
machine.  We must move the three dimensional grid, so the position of the workpiece datum 
registers as zero, rather than the position of the machine datum. 

It is important to note that the physical position of the machine datum does not move, since it is 
permanently fixed.  Remember, it's the co-ordinate based grid system of the CNC machine that 
temporarily moves, giving the illusion that the machine datum itself has moved. 

Note that the workpiece datum must be positioned on the real billet in the same place as the part 
datum datum was positioned with respect to the imaginary billet.  Compare the position of the 
workpiece datum in the diagram below with the position of the part datum in the diagram above - 
they are identical.  If these datums were not identical, the part would be machined in the wrong place 
on the real billet. 

 

However, that there may be occasions when you want to set the workpiece datum in different 
positions.  For example, if you have a number of different CNC files that combine to make a part.  If 
these CNC files don't use a common part datum between them, you would have to set workpiece 
datums individually so each CNC file machines in the correct area of the real billet.  Or you might 
want to machine the same CNC file a number of times on the same billet to produce identical parts.  
Then you would need to set separate workpiece datums for the position of each part. 

Offsets are very important because without them, the CNC machine will not know where to begin 
cutting on the billet.  Offsets must always be configured before manufacturing our part.  However, 
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once you configure and save an offset file, the same file may be used over and over again, as long as 
the following holds true: 

- The same cutting tools are used. 

- The billet size does not change. 

- The fixture that holds the billet does not move position on the machine table. 

Bearing this in mind, offset files can be created using titles for specific projects or student groups to 
save setup time during lectures. 

 

  

CNC Theory: Types of Offset 

Offsets are configured in two distinct stages: 

1) Workpiece Offsets 

A workpiece offsets file contains three values relating to any co-ordinate shift required along the 
direction of the X, Y and Z axes. 

Without any workpiece offsets file loaded, the zero co-ordinate of the CNC machine is the location 
of the machine datum. 

Workpiece offsets are used to temporarily shift the entire co-ordinate based grid system of the 
machine, setting a new location for the zero co-ordinate of the CNC machine. 

Any values entered into a workpiece offsets file are global, i.e., they are used by all tool profiles, 
irrespective of their different lengths. 

2) Z Tool Length Offsets 

Z Tool Length Offsets apply along the direction of the Z axis only. 

They allow a variety of tool profiles to be used together on the same CNC program, by offsetting 
their differences in length against a common fixed reference point. 

Each tool has its own individual Z tool length offset value that is only applied when that particular 
tool is used on the CNC machine. 

When Z tool length offsets are used, their values are combined with any Z value entered into the 
loaded workpiece offsets file, to calculate the Z co-ordinate describing the location of the workpiece 
datum. 
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CNC Theory: Configuring Offsets when using 
only one Tool 

This sequence briefly explains the theory behind configuring the offsets, when using only one tool 
with a CNC program. 

This sequence can save considerable time when configuring the offsets, when using only one tool. 

 

1) Defining the X position of the workpiece datum. 

When the tool is at the home position, the X offset position is defined as the distance between the 
centre of the tool and the workpiece datum, parallel to the X axis.  The X offset is the value entered 
into the X component of the workpiece offsets file, this will be a negative value. 

2) Defining the Y position of the workpiece datum. 

When the tool is at the home position, the Y offset position is defined as the distance between the 
centre of the tool and the workpiece datum, parallel to the Y axis.  The Y offset is the value entered 
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into the Y component of the workpiece offsets file, this will be a negative value. 

3) Defining the Z position of the workpiece datum. 

When the tool is at the home position, the Z offset position is defined as the distance between the 
centre of the tool and the workpiece datum, parallel to the Z axis.  The Z offset is the value entered 
into the Z component of the workpiece offsets file, this will be a negative value. 

Note that the Z position of the workpiece datum is defined by the Z value in the workpiece offsets 
file only.  Since workpiece offset file values are global, no other tool profile can be used because the 
Z offset would always be set for the length of the original tool. 

 

  

CNC Theory: Configuring Z Tool Length 
Offsets 

When a tool is called into use on a CNC machine, the Z component of the workpiece datum is a 
numerical combination of the the Z tool length offset value for tool profile being used and the value 
entered into the Z component of the workpiece offsets file. 

The Z tool length offset facility is used to compensate for the differences in length between all the 
tools used with the CNC program. 

How are Z Tool Length Offsets used? 

This sequence briefly explains the theory behind configuring the Z tool length offsets. 

The Z position of the workpiece datum is defined by the Z value in the workpiece offsets file and the 
appropriate Z tool length offset values relating to each of the tools you want to use. 

In this example, tool profile 1 has a greater length compared with tool profile 2. 
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Define a Tool Offset Reference Point. 

All Z tool length offsets are configured against a common reference point.  When values are entered 
into each individual Z length tool offset file, each tool will use this reference point as their zero co-
ordinate along the Z axis. 

Choose a tool offset reference point that's easy to reach with all the tool profiles you intend to use.  
The tool offset reference point could be the top surface of the billet or the top surface of a temporary 
machine bed.  In the above example, we have chosen the upper surface of the temporary machine 
bed as the tool offset reference point. 

Define the Z tool length offset value for tool profile 1. 

When the tool 1 is at the home position, the Z tool length offset value will be the distance between 
the tip of tool 1 and the chosen tool offset reference point.  In the above example, we have chosen 
the upper surface of the temporary machine bed as the tool offset reference point. 

Define the Z tool length offset value for tool profile 2. 

When the tool 2 is at the home position, the Z tool length offset value will be the distance between 
the tip of tool 2 and the same tool offset reference point used for tool 1. 

Notice that the numerical value of the Z tool length offset for tool profile 2 will be larger than the 
numerical value of the Z tool length offset for tool profile 1.  This compensates for the fact that tool 
profile 1 is longer than tool profile 2.  This compensation allows the machine to cut in the correct 
place on the billet, irrespective of whether it is using tool 1 or 2. 

To configure the Z tool length offset for a tool profile: 

1) Move the cutting tool so its tip is just touching the chosen tool offset reference point. 

2) Click the [Z Offset] button in the "Jog Mode" panel of the "Machine Mode" window, to display 
the "Set Offset" window. 

3) Enter the Z tool length offset value into the "Set Offset" window dialogue box, if required.  The 
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VR CNC Milling software will automatically suggest a value for the tool currently held in the 
machine head - this suggested value will set the position of the tool tip as the zero reference point. 

4) Click the [OK] button to confirm the Z tool length offset value. 

5) Repeat steps 1 through 4 for all remaining tools, ensuring that the same tool offset reference point 
is used form step 1.  Note that the data in the "Set Offset" window will only be applicable to the tool 
profile currently held in the machine head. 

How is the Z Tool Length Offset value used? 

Remember that the Z position of the workpiece datum is a numerical combination of the the Z tool 
length offset value for tool profile being used and the value entered into the Z component of the 
workpiece offsets file. 

If the Z value in the workpiece offset file was left as zero, the Z component of the workpiece datum 
would be in the same position as the tool offset reference point. 

In our above example, if the Z component of the workpiece datum needed to be the upper surface of 
the billet, a value equal to the thickness of the billet would be manually entered into the Z dialogue 
box of the workpiece offset file.  This would shift the workpiece datum up to the correct position. 

Note that the value manually entered into the Z dialogue box of the workpiece offset file will be sign 
sensitive.  A positive value will move the workpiece datum up, whilst a negative value will move the 
workpiece datum down. 

 

  

CNC Theory: Using Workpiece Offset Z 
Values as Material Thicknesses 

If you find that you always seem to place the real billet and its temporary machine bed in exactly the 
same position on the machine bed, then this sequence can be used so offsets need only be configured 
once, so long as the following holds true: 

- The position of your temporary machine bed on the machine table never changes. 

- The X and Y workpiece datum position never changes, i.e., the X and Y edges of the real billet 
always align with the X and Y edges of the temporary machine bed. 

- The thickness of the temporary machine bed never changes. 

- The part datum, defined in your CNC files, is always positioned in the top left-hand corner of the 
proposed billet (note that this position can be automatically chosen as the part datum in CAD/CAM 
software packages, such as Denford MillCAM Designer).  We recommend this position since any 
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negative Z values in the CNC file will show that the tool is cutting into the billet. 

This sequence effectively sets the workpiece datum at the top left-hand corner of the temporary 
machine bed.  Then, by entering the thickness of the billet into the Z component of the workpiece 
offsets file, you can move the workpiece datum to the top left-hand corner of the real billet. 

 

Remember that when using two or more tool profiles with a CNC file, the Z position of the 
workpiece datum is a numerical combination of the the Z tool length offset value for tool profile 
being used and the value entered into the Z component of the workpiece offsets file.  The workpiece 
datum is the position where any machining co-ordinates are read from. 

Set the X and Y components of the workpiece datum against the top left-hand corner of the 
temporary machine bed.  The X and Y offset values are entered in the workpiece offset file.  You 
only need to do this using one tool profile.  Remember, values in a workpiece offset file are global - 
they will be used by all other tool profiles. 

Now, set all your individual Z tool length offsets against a common reference point.  This will be the 
top surface of the temporary machine bed. 

You have now set the workpiece datum in the top left-hand corner of the temporary machine bed, for 
all your tool profiles.  We call this position the 'workpiece datum including no global Z offset' in the 
above example. 

Remember that the part datum, defined in your CNC files, is always positioned in the top left-hand 
corner of the proposed billet.  So when we place the real billet on the temporary machine bed, you 
must shift the workpiece datum further up the Z axis so it aligns with the top left-hand corner of the 
real billet.  You do this by manually entering a value equal to the thickness of the billet into the Z 
dialogue box of the workpiece offsets file.  Note that this value will be sign sensitive - a positive 
value will move the workpiece datum up, whilst a negative value will move the workpiece datum 
down.  We call this value the 'global Z offset', since it will be used by all tool profiles. 

The workpiece datum is now in the correct position, ready for machining to take place.  We call this 
position the 'workpiece datum including global Z offset' in the above example. 

In the future, if you load a CNC file that uses a different thickness of billet, all you have to do is 
change the Z value in the workpiece offsets file.  This new value should be the thickness of the new 
billet.  No other changes are necessary to the workpiece offsets file or Z tool length offsets. 
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Using the Toolbars  

The various toolbars in the software can be repositioned to form different screen layouts, as required.

Docked Toolbar Example. 

 

A docked toolbar can be positioned anywhere on the main software window docking bars.  Docking 
bars are provided on the top, left-hand and bottom grey border edges of the main software window.  
To move a docked toolbar click and hold your left mouse button on the two grey lines at the end of 
the toolbar (circled red in the screenshot above).  Drag the toolbar to the new position and release the 
mouse button.  To undock a toolbar, drag it off the window docking bar into the main software 
window, then release the mouse button. 

Undocked Toolbar Example. 
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An undocked toolbar can be positioned anywhere in the main software window.  To move an 
undocked toolbar click and hold your left mouse button on the toolbar titlebar (circled red in the 
screenshot above).  Drag the toolbar to the new position and release the mouse button.  To dock a 
toolbar drag and position it over one of the grey border edges of the main software window. 

  

Note - Only toolbars can be docked and undocked.  Any windows appearing through use of the 
toolbar buttons can only be displayed in the main software window. 

If you are unsure about the function of any toolbar button, hover your mouse cursor over the button 
to display a pop-up hint caption. 

  

 

  

The File Control Toolbar 

 

File Control buttons, listed from left to right: 

[Play]:  Click this button to start running the CNC file currently loaded in the "Editor" window.  If 
no output option for the CNC file is selected you will be prompted to select one before the CNC file 
is executed.  The CNC file will start playing from the cursor position in the "Editor" window. 

[Pause]:  Click this button to pause the playing of a CNC file.  To restart the CNC file from the 
paused line,click the [Play] button again. 

[Stop]:  Click this button to stop the playing of a CNC file.
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[Rewind to Start]:  Click this button to move the cursor position in the "Editor" window back to the 
start of the CNC file.  

Note: Buttons are greyed out when unavailable. 

 

  

The Options Toolbar 

 

Outputs buttons, listed from left to right: 

Units - Click this button to switch the units of measurement between Metric (millimetres) 

and Imperial (Inch).  The current setting of the option is displayed in the main program status bar.  
This option can also be configured using the "Setup | Units" menu option. 

Tool and Offsets Editor - Click this button to display the "Tool and offsets editor" window, 

used to configure any tool offsets to be used with the CNC file. 

Block Skip - Click this button to active the block skip option.  The current setting of the 

option is displayed in the main program status bar.  When active, any blocks are ignored by the 
control when a forward slash character, / , is placed in front of the block. 

Click here for more about Block Skip 

Continuous - When the CNC file is started, all program lines will be executed until the 

program is paused, stopped, an error is encountered or the end of the program is reached. 

Step - When the CNC file is started, the program will only run one line at a time. The 

[Play] button or the [Enter] key on the computer keyboard must be pressed to execute the next 
program line. 
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Click to switch between "Continuous" or "Step" modes, defining the methods used for running any 
CNC file.  The current setting of the option is displayed in the main program status bar.  This option 
can also be configured using the "Setup | Execute Mode" menu option. 

Block Search - Click this button to activate the block search window. 

Program Information - Click this button to activate the Program Information window. 

 

  

The Modal Data Status bar  

 

The "Modal Data" window displays information about the last code values used by the VR CNC 
Milling software.  Hold the cursor over the required code value to display a pop-up hint description, 
as shown above. 

Data is provide for the following categories: 

Last G code used from a specific Modal Group. 

Click here for more about Modal and Non-modal G codes. 

Last M code used. 

Last Spindle Speed used. 

Last Tool Number used. 
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The Main VR CNC Milling Program Status 
bar 

The main VR CNC Milling status bar is displayed in the bottom left corner of the main program 
window, circled red in the screenshot below. 

 

Information is displayed along two rows. 

 

Upper row (boxed information listed from left to right): 

1) Units of Measurement, defined by "Metric" (Metric - millimetre units) or "Inch" (Imperial - inch 
units). 

2) Block Skip Mode, defined by "Block Skip OFF" (CNC file lines beginning with a / character are 
included) or "Block Skip ON" (CNC file lines beginning with a / character are excluded) 

3) Editor Play Mode, defined by "Continuous" (CNC file plays from start to finish) or "Single 
Step" (CNC file plays one line at a time). 

4) Cycle Time: Recorder time taken to run the last program (the time taken to run a simulation is not 
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an accurate estimation of the time it would take on a real machine, but the actual time taken to 
simulate it on the screen). 

5) File: (name of the loaded CNC file). 
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Using the Menubars  

The VR CNC Milling software menubar (circled red in the screenshot below) is located under the main 
software title.  It contains text captions identifying each individual menu. 

 

To display the options available in each menu, click the menu text title to display its dropdown list (as 
shown below), then move the mouse cursor down the list to highlight the options.  Click the 
highlighted option to select it or display its sub-menu, when available. 

 

The menus available will change according to the windows that are active in the software. 

When the software is first started, the following menus are available: 

File  Editor  Windows  Utilities Help 

Additional Menus become available on selection of various software options: 

Simulation (2D/3D) on selection of the [2D/3D Simulation] button. 

Simulation (VR - 3D - 2D) on selection of the [VR Machine] button. 
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Offsets / Tooling  on selection of the [Tool and Offsets Editor] button. 

 

  

The File Menu  

 

New:  Select this option to create a New File in the "Editor" window.  

Open:  Select this option to open a file.  Files that can be opened include FANUC Miller files (.fnc), 
Denford Compiled CNC files (.xnc) and Denford CNC Project files (.prj). 

Other file types listed in the 'Files of type' drop down, are those assigned to application listed in the 
configure utilities window. Selecting one of these files will automatically launch the application 
associated with it 

.  

Open Project...:  Select this option to load a Denford Project File (.prj). 

ReOpen:  Select this option to display a secondary menu of recently opened files.  Highlight and click 
on the chosen file to load it into the software. 

Save:  Select this option to save any changes made to a previously saved file. 

Save As:  Select this option to save a file in a specific directory and folder with a user defined 
filename.  Files can be saved as either a FANUC Miller file (.fnc), Text Only file (.txt) or Any File of 
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your choice. 

Save Project...:  Select this option to save a Denford Project File (.prj). 

Source:  Select this option to display a secondary menu allowing configuration of the CNC file 
display. 

 File:  Select this option to remove the "Editor" from the screen and replace it with a progress bar 
as shown below.  Programs run in this mode will run faster and is recommended whenever larger 
CNC files are both simulated and executed on the machine.  Using the "File Input" window will 
not allow any editing of the code.  

 

 Editor:  Select this option to display the CNC file in the "Editor" window.  The CNC file is 
displayed in full.  Lines of code can be manually edited, through using the window in the same 
way as a word processor.  

 Compiled:  Select this option to display the CNC file in the "Compiled Input" window.  The 
CNC file is compiled into a format that allows faster processing of any 3D elements used in the 
VR CNC Milling software.  

Program Pre-Scan: CNC programs are Pre-scanned for errors before they are loaded into the editor. 
With this option ticked, programs may take longer to load. 

Exit:  Click this option to close down the VR CNC Milling software. Note: The Real Machine and the 
VR Machine windows must both be closed before you can close down the software. 

 

  

The Setup Menu 
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Units:   

 Metric:  Metric units - millimeters.  
 Inch:  Imperial units - inches.  

View:   

 Cycle Expansion:  Expands program cycles to show full code at the base of the "Editor" 
window, when the CNC file is run. 
Click here for more about "Cycle Expansion"  

Execute Mode:   

 Continuous:  When the CNC file is started, all program lines will be executed until the program 
is paused, stopped, an error is encountered or the end of the program is reached.  

 Step:  When the CNC file is started, the program will only run the line on which the "Editor" 
window cursor is placed.  The [Enter] key on the computer keyboard must be pressed to execute 
the next program line.  

ToolBars:  Select this option to configure between different styles of toolbar presentation. 

 View:  Select this option to open the "ToolBar Setup" window.  This window allows the settings 
for each toolbar button to be configured and may be password protected.  Note - the fields in this 
option should only be edited by your CNC machine Technician or Supervisor.   

 Load Level 1 Defaults:  Small format toolbar buttons (graphics only).  
 Load Level 2 Defaults:  Large format toolbar buttons (graphics and text).  
 Load Level 3 Defaults:  Small format toolbar buttons (text only).  

Materials:  Materials define the settings used in the materials override button in the auto mode. 

 Load - Loads a material file for use in the materials override.  
 Save - Saves the current settings in the Material Editor.  
 Edit Materials - Displays the Material Editor window.  

Select Machine ...:  Select this option to reconfigure the software for a specific CNC machine. You 
must close the VR machine or Real machine first for this option to become available. Click here for 
more information. 

Setup Machine Parameters...:  Select this option to access the software configuration editor.
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Jog Keys : Select this option to open the "Axis Key Definition" window.  This window may be 
password protected and allows you to reconfigure the jog keys and function keys defined from the 
keyboard.  

Select Language... :  Select this option to change the type of language used for the software menus, 
toolbars and windows, from the language options available. 

Macro Variables : The macro variables window displays the values assigned to the variables when 
using macro programming. 

Default Billet Size...:  Select this option to define the size of the billet used in the "2D/3D Simulation" 
and "VR-3D-2D Simulation" windows. Click here for more on "Default Billet Size..." 

: 

 Toolbar Defaults  

 

  

The Windows Menu  

 

Cascade:  Select this option to display any open windows in a cascading pattern, one on top of 
another. 

Click here for more about "Cascade" 

Tile:  Select this option to display any open windows in a tiled pattern, one next to another. 

Click here for more about "Tile" 
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The Utilities Menu 

 

Configure Utilities...:  Select this option to display the "Configure Utilities" window, used to setup 
shortcuts to other programs using the MS Windows Operating System. 

Additional options will appear in this menu as they are added in the Configure Utilities, and therefore 
your menu may look something like the example below. 

 

 

  

The Help Menu  

 

VR CNC Milling:  Select this option to display the contents page for VR CNC Milling for Windows 
software help file.  This help file contains VR CNC Milling tutorials, detailed information about the 
various features of the VR CNC Milling software, troubleshooting guides and a guide to CNC Theory. 

CNC Programming:  Select this option to display the contents page for the CNC Milling 
Programming help file.  This help file contains detailed information about individual G and M codes 
and structure of CNC files. 

Context sensitive help is also available: 
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 Menu:  To obtain context sensitive help on a software menu, click the menu title to display its 
drop down list of options, then press the [F1] key. Click here for more about Context Sensitive 
Menu Help  

 Window:  To obtain context sensitive help on a software window, press the [F1] key when the 
required window is active. Click here for more about Context Sensitive Window Help  

 G and M codes:  To obtain context sensitive help on an individual G or M code, position the 
"Editor" window cursor in the middle of the text for the code required, then press the [Ctrl + F1]
keys. Click here for more about Context Sensitive G and M code Help  

About...:  Select this option to display information about the VR CNC Milling software, including the 
version number. 

Support Me !:  When contacting Denford support staff it is useful to have as much information 
available when trying to solve a problem. The "Support Me !" takes all the current configuration 
settings and information about the current CNC program in use and generates a data file. This file can 
then be written to disc or sent via email directly to Denford customer services. 

 

Registration...:  Opens the registration details window, used when upgrading your registration key 
setting. 
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The Editor Menu 

 

The Editor menu is only available when the "Editor" window is active. To activate the window, click 
on the title bar at the top to select it as shown in red below. 

 

Hi-Light:  Select this option to display a secondary menu that allows certain address characters in your 
CNC file to be hi-lighted.  Note - only one address character can be hi-lighted at any one time.
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Click here for more about "Hi-Light". 

G:  G code - Preparatory function. 

M:  M code - Miscellaneous function. 

T:  Tooling management. 

F:  Feed rates. 

S:  Spindle speeds. 

X:  Absolute/incremental distance travelled by the slide tool in the X axis direction. 

Y:  Absolute/incremental distance travelled by the slide tool in the Y axis direction. 

Z:  Absolute/incremental distance travelled by the slide tool in the Z axis direction. 

I:  Distance command (used in conjunction with J) to identify arc centre co-ordinates. 

J:  Distance command (used in conjunction with I) to identify arc centre co-ordinates. 

Show Normal:  Select this option to remove any hi-lights applied to your CNC file. 

Printer Setup...:  Select this option to configure the type of printer you wish to use for printing out any 
CNC files. 

Print...:  Select this option to print the contents of the "Editor!" window. 

Edit: Select this option to display a secondary Edit menu.  

Search: Select this option to display a secondary Search menu.  

Modify: Select this option to display a secondary Modify menu.  

Preferences: Select this option to display a secondary Preferences menu.  

 

 The Editor Window  

 

  

The Simulation Menu (VR - 3D - 2D) 
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The Simulation menu is only available when the "VR - 3D - 2D Simulation" window is active. To 
activate the window, click on the title bar at the top to select it as shown in red below. 

 

Billet Materials... 

Select this option to change the billet settings defined in the VR Billet Setup. 

Base Type... 

A sub-table can be added to the VR machine table. To protect the table on a real machine, a piece of 
material, e.g. MDF board, can be placed on the table and then the billet placed on top of that. Click 
here to find out more. 

Work Holder 
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Select this option to add various work holding options to the virtual machine table. 

Set Billet Position 

Select this option to define the default billet size used in the simulation. 

Select Mode 

Switches the simulation window between 2D view and 3D view . 

Options 

 Show Options as Buttons - Adds or removes the graphical buttons displayed at the top of the VR 
- 3D - 2D Simulation window as shown below. 
 

  
 Auto Save Bitmap - A 'thumbnail' image of the simulation can be automatically saved to disc 

which in turn is then displayed against the selected filename when using the "File | Open" 
option. 

 
Note : This facility is not available for files save to 3.5" Floppy Discs.  

Auto Datum 

Double Sided Tape Datum Plate Bottom Left Datum Plate Bottom Right

Datum Plate Top Right Datum Plate Top Left
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The work piece and tool length offsets must always be configured correctly on the real machine. 
However, if you just want to run the VR - 3D - 2D simulation without having to set the offsets, the 
Auto Datum facility can be used. 

When the Auto Datum is unticked - the workpiece and tool length offsets must be set in the same way 
as the real machine. 
 
When the Auto Datum is ticked - The current workpiece offsets and tool length offsets are ignored, and 
the work piece datum will be taken from the settings specified in the "Datum Position..." menu. 
 
Datum Position... 

Defines the position on the billet to be used for the datum when the "Auto Datum" option is ticked. 
Click here for more information. 

Turbo Settings... 

Defines the way the billet is simulated in turbo mode. Click here for more information. 

Navigation Setting... 

Sets the speed you move around in the VR - 3D - 2D simulation. Click here for more information. 

Graphical Information... 

Checks the settings of your graphics card, useful when trying to resolve display problems. Click here 
for more information. 

 

 Using the menu bars  

 

  

The Simulation Menu (2D / 3D) 
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The Simulation menu is only available when the "2D - 3D Simulation" window is active. To activate 
the window, click on the title bar at the top to select it as shown in red below. 

 

Billet Materials... 

Select this option to change the billet settings defined in the VR Billet Setup. 

Select Mode 

Switches the simulation window between 2D view and 3D view . 

Options 

 Show Options as Buttons - Adds or removes the graphical buttons displayed at the top of the VR 
- 3D - 2D Simulation window as shown below. 
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 Auto Save Bitmap - A 'thumbnail' image of the simulation can be automatically saved to disc 
which in turn is then displayed against the selected filename when using the "File | Open" 
option. 

 
Note : This facility is not available for files save to 3.5" Floppy Discs.  

Datum Position... 

Defines the position on the billet to be used for the datum when the "Auto Datum" option is ticked. 
Click here for more information. 

Turbo Settings... 

Defines the way the billet is simulated in turbo mode. Click here for more information. 

Graphical Information... 

Checks the settings of your graphics card, useful when trying to resolve display problems. Click here 
for more information. 

 

 Using the menu bars  

 

  

The Offsets / Tooling Menu 
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The Offsets / Tooling menu is only available when the "Tool and Offset Editor" window is active. To 
activate the window, click on the title bar at the top to select it as shown in red below. 

 

Information in each of the Work Offsets, Tooling Data, Tool Library screens can be saved in the 1st 3 
menus. 
 
The "Load All" and "Save All" menus allows you to save and load the entire contents of the Tool an 
Offset Editor window all at once. 

Work Offsets 

 Load – loads data into the "Work Offsets" screen.  
 Save – saves any changes made in the "Work Offsets" screen. 

Tooling 

 Load – loads data into the "Tooling Data" screen.  
 Save – saves any changes made in the "Tooling Data" screen. 

Tool Library 

 Load – loads data into the "Tool Library" screen. 
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 Save – saves any changes made in the "Tool Library" screen.

Load All - loads data into all three screens of the Tool an Offset Editor window 

Save All - saves the entire contents of the Tool an Offset Editor window  

 

 Using the menu bars  
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Troubleshooting - connecting to the machine 

If the software is unable to connect to the CNC machine, a warning window will be displayed, as 
shown below. 

 

Click the [OK] button to clear the window. 

Rectify the connection problem before attempting to reconnect.  The most common problems 
encountered include: 

1) The CNC machine was not switched on before a connection was attempted.  The CNC machine 
must be switched on before clicking the [Machine] button. 

2) The connections at both ends of the RS232 lead between the computer and the CNC machine are 
insecure. 

3) The software is not configured to the correct CNC machine type in use. Click here for more 
information on how to configure your software.  

To select a different CNC machine, click the right mouse button on the name of the CNC machine 
required, then highlight and click the "Set As Active Machine" option from the pop-up list.  Click the 
[OK] button to confirm any changes. 

6) The serial ports on the computer are in use by another software program running 'in the 
background'. A typical example of such a program would be software that interfaces with a PDA or 
similar electronic device. 

5) The serial port on the computer may be faulty... try a different port or fit an additional serial card.

Page 1 of 6

15/12/2010



 

  

 

Troubleshooting - homing the machine 

Please check the following if you are having problems 'homing' the machine. 

1. Guard - Check that the guard is thoroughly closed . Try opening and closing the guard again 
making sure the 'Not Ready' message disappears from the control panel shown below. 

 

2. Emergency Stop - The 'Emergency Stop' message must be cleared before you can home the 
machine. 
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Check that the emergency stop button is in the out position. 
If your machine has a key switch on the front of the machine, use the key to switch the drives 
on before homing the machine. 
If your machine has a 'Drives On' button, press the button to switch the drives on before 
homing the machine. 

3. Clear the slideways of debris - Check all the axis slideways are clear of any objects that may 
inhibit machine movements to the datum sensors. An axis failing to reach a datum sensor 
would be identified by the relevant home axis button failing to turn green.  

4. Software Configuration - Ensure your software is configured to the correct machine type as 
specified in the "Setup | Select Machine ... menu - an incorrect machine type could cause the 
CNC machine to connect successfully but then datum in the wrong direction.  

 

 Troubleshooting connecting to a real machine  
 Error messages  
 4th Axis (option)  
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Error Messages 

M/C Limit Error 

 

This message indicates that the cutter is trying to move to a position outside of the working envelope
of the machine. This could be caused by : 

1. The tool offsets not being set or set incorrectly.  
2. The design is too big for the CNC machine.  

 

Click the [Details >] button to establish the line number in the CNC program that is causing the error 
and on which axis. 

Note: If the real machine is in use and the 'turbo' mode is active, the actual line number displayed 
could be 'ahead' of the line number executed on the machine. 

Tip: Use the Program Information facility to check that the program will run before executing it on 
the machine. 

Communication Problems 
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The above error messages are caused when the computer is having problems sending or receiving 
data to and from the CNC machine. Check the cable connections, or try a more powerful computer 
(see computer specification) 

 

 Troubleshooting homing the machine  
 Troubleshooting connecting to a real machine  

 

  

 

Technical Support 

Before contacting technical support, please read the documentation in your training course manuals 
and check the Denford website for support. 
Internet (access technical support and FAQ sections): http://www.denford.com 

When you request technical support, please be at your computer workstation, with your hardware 
and software documentation to hand. To minimise delay, please be prepared to provide the following 
information:  

1. Registered school/college name or company name. 

2. In the case of software problems, the specific nature of the problem, including the wording of 
any error messages that appear on your computer screen, if applicable. 

3. A list of the steps that were taken to lead up to the problem. 

For Technical Support or for any other queries click . 
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